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Gontents at a glance

This user’s manual contains the information you need to efficiently use
ASUS® MyPal A620BT Pocket PC.

Chapter 1 - Get started! ........ccvvveiieiie e 1-1
This chapter introduces the ASUS MyPal A620BT Pocket PC, how to
set and power it up, and basic screens that will familiarize you with
its many features.

Chapter 2 - Learn the basiCs ......c.cccccevvveviiiiii e, 2-1
This chapter will teach you the basic functions in MyPal A620BT. You
will learn how to enter, find, and organize information, customize the
device, and use the bundled ASUS utilities.

Chapter 3 - Microsoft® ACtiveSYnc®......ccccccvvvevveieiieneese e 3-1
This chapter tells you how to use the Microsoft® ActiveSync® to
synchronize your device with your desktop computer.

Chapter 4 - Microsoft® Pocket Outlook ..........cccceeveiiieiieennee, 4-1
This chapter details the procedures for the Microsoft® Pocket Outlook
Calendar, Contacts, Tasks, Notes, and Inbox.

Chapter 5 - Companion programs .........cccceevveeveeiiveeseesneesinenns 5-1

This chapter includes information on Pocket Word, Pocket Excel,
MSN Messenger, Windows Media Player for Pocket PC, and
Microsoft Reader.

Chapter 6 - Pocket Internet EXpIOrer ........cccccveveiiv e ccieecinenn, 6-1
This chapter gives information and procedures on using Pocket
Internet Explorer, Mobile Favorites folder, and AvantGo interactive
service.

Chapter 7 - Get connected .........cccoccveveeiiiecie e, 7-1
This chapter provides the procedures for connecting to the Internet,
and for transferring data using infrared (IR).

Chapter 8 - BIUetOOth™ L. ..., 8-1
This chapter provides information on using the Bluetooth feature
built-in the device.

APPENTIX - NOLICES ... A-1
This part includes the safety notices and regulations.
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MyPal R620BT specifications

Processor
Software

Memory

Display

Card slot
Connection

Audio

Intel PXA255 400 MHz

Microsoft Pocket PC 2003

64MB SDRAM (55.2 MB user accessible)
64MB Flash ROM

3.5-inch, 240x320 pixels
65,536 colors, Transflective TFT LCD

CompactFlash (CF) Type Il slot

Bluetooth, FIR/SIR

Stereo headphone jack
Built-in microphone
Built-in speaker

125 mm x 76.8 mm x 13.3 mm (L x W x H)
4.921in.x3.021in.x0.52in. (LxW x H)

Approximately 141g

MyPal A620BT package

Your package includes several accessories for the Pocket PC. After
unpacking, check the items against the list below and make sure that they
are in good condition. If any item is missing or damaged, contact your
dealer or retailer immediately.

Standard package contents Optional accessories

+ USB cradle with sync cable

ASUS MyPal A620BT

AC adapter
Input:  100V~240V
Output: 5V 2A 10W

Stylus

Microsoft Companion CD

Bonus CD (optional)
User’s Manual
Quick Start Guide
Warranty card

Stylus

Car charger

Foldable keyboard*
Leather handheld case
Leather waist case

Traveling USB sync cable

Cradle with cable
AC adapter with plug

(UL/CEE/UK/SAAICCEE)

GPS mouse

CF GPS card

CF wireless LAN card
CF LAN card

CF modem card
CF camera card

CF VGA card

CF FM radio card
CF GPRS card
Bluetooth dongle
Bluetooth GPS
Bluetooth earphone

* English version keyboard. Visit the ASUS website to check the availability of other language version keyboards.
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Introducing MyPal

The ASUS® MyPal A620 is truly a good companion wherever you go.
Powered by a 400MHz Intel® PXA255 processor, equipped with 64MB
SDRAM and 64MB Flash ROM, and bundled with the latest Microsoft
Pocket PC 2003 plus a host of useful utilities, you have everything you
need in your pocket!

Front features

Power button/ Record button/
Backlight button Notes button
— Built-in microphone
A —TF N
4

Pocket PC \
N

LCD touch screen

— Contacts button
— Tasks button

Calendar button —
ASUS Launcher button —

°_+— Speaker

Navigation button

» Power/Backlight button - turns the device power on or off if you press
the button quickly. Pressing and holding the button for a few seconds
turns the backlight on or off. Turning off the backlight saves battery
power.

NOTE Press this button and the Tasks button simultaneously if you
wish to launch the Align Screen function.

» Record/Notes button - allows you to record sounds and save them as
files if you press and hold the button, or launches the Notes program
when pressed once.

* Built-in microphone - magnifies your sound recording.

1-2 Chapter 1
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« LCD touch screen - allows you to enter, read, send, receive, or edit data
by tapping on it. The screen lumination is increased or decreased by
changing the backlight settings.

« ASUS Launcher, Calendar, Tasks, and Contacts buttons - allow you
quick access to commonly used programs.

» Navigation button - functions like the four arrow keys and the Enter key
on a keyboard. This multifunction button allows you to:

- move through the program icons, folders, or files in a menu by
scrolling up or down

- launch a selected program, list folder contents, or open a file by
pressing the center of the button

» Speaker - allows you to hear alarms and other sound outputs from the
device.

Left side features

]
% Charging status LED
Bluetooth LED (blue);

System notification LED (red)

[} Infrared (IR) port

LD

« Charging status LED - lights up orange when the battery is charging;
lights up green when the battery is fully charged.

« Dual-function LED
Bluetooth LED (blue) - blinks blue when Bluetooth is ON;
does not light up when Bluetooth is OFF.
System notification LED (red) - blinks red to notify you of a
scheduled event

» Infrared (IR) port - allows you to copy or send data to another device
with an IR port.

Get started! 1-3
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Top features

C m—

{
[ —" | |

Headphone jack CF card slot Stylus

» Headphone jack - connects a headphone.

* CF card slot - accommodates a CompactFlash (CF) card. See list of
supported CF cards on page iv.

« Stylus - used for tapping or writing on the LCD touch screen. Slide out
the stylus from its compartment. Refer to the description of the stylus on
the next page.

Bottom features

— — — ~

| |

) =) {
Cradle connector / Power connector

Sync cable connector

« Cradle connector / Sync cable connector - connects to the 26-pin
female connector on the cradle. If you are not using the cradle, connect
the 26-pin USB sync cable directly to this connector to synchronize your
device with your computer.

» Power connector - connects the AC adapter cable. Use this connector if
you wish to use AC power without the cradle.

1-4 Chapter 1
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Back features

- ™
®
CF card slot cover
N —
O (@]
Reset swittch ——©
@
I I

* Reset switch - allows you to perform a soft reset in case the device
malfunctions, or when an application hangs. Press the tip of the stylus on
the switch to reset the system.

» CF card slot cover - protects the slot connector and the CF card.

The stylus

The stylus functions on a Pocket PC the same way a mouse functions on
a standard PC. Use the stylus to tap or drag on the LCD touch screen to
open programs or execute commands.

» Tap. Touch the screen once with the stylus to open programs and select
options.

« Drag. Hold the stylus on the screen and drag across the screen to select
text and images. Drag in a list to select multiple items.

« Tap and hold. Tap and hold the stylus on an item to see a list of actions
available for that item. On the displayed pop-up menu, tap the action that
you want to perform.

Get started! 1-5
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The cradle

The cradle has three connectors.

» Device connector - holds the device in place. This is a 26-pin connector
that matches the connector on the bottom of the device.

« USB connector - synchronizes the device with your PC.

NOTE The USB cable/connector is not detachable from the back of
the cradle.

» Power connector - connects the bundled AC adapter. This connector is
located at the back side of the cradle.

NS

Device connector Power connector

1-6 Chapter 1
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Setting up MyPal

Placing on the cradle

Position the device on the cradle as shown. Match the connectors and
carefully insert the device until it fits in place.

Connecting the AC adapter

« Connect the AC adapter cable to the connector at the back of the cradle.
Connect the power plug to a grounded wall socket. See Figure 1.

 Ifyou are not using the cradle, connect the AC adapter cable directly to
the power connector at the bottom of the device. Connect the power plug
to a grounded wall socket. See Figure 2.

Figure 2

Get started! 1-7
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Installing and removing a CF card

The CF card slot on your device supports several types of CF card. Refer
to the list of supported cards under “Optional Accessories” on page iv of
this manual.

Install a CF card for additional storage, or if you wish to use the ASUS
backup features.

To install a CF card;

1. Locate the card side with the 50-pin female connector and insert into
the slot. The label side (usually the side with the card manufacturer’s
name) face down, and the bar code/serial number side face up.

Bar code/Serial number side

Label side/Manufacturer’s name

NOTE A CF card fits only in one orientation, and slides smoothly into
the slot if inserted correctly. DO NOT force the CF card into
the slot!

2. Push the card all the way into the slot until it fits completely. If properly
installed, the CF card edge aligns with the top edge of the device.

1-8 Chapter 1
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To remove a CF card:

1. Remove the CF card slot cover by pushing on the dent on the surface,
and sliding the cover outward.

Dent on the cover surface

Get started!
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Charging the battery

Your device includes a rechargeable Lithium [ EEatE &t AT @

lon battery. You must charge the battery Power

before using the device the first time. The sl (I il

battery starts charging as soon as you 0 [ | 100

connect the AC adapter to a power source.

Use the AC adapter to plug your device to a

power source whenever possible, especially

when you are using a modem or other

peripherals, using the device backlight,

connecting to a PC, or letting notification Battery | Wireless | Advanced |

light flash for extended time periods. Adjust backliht settings to conserve power.,
Change beam settings to conserve power,

To display the power status, tap [ , -

Settings, System tab, and the Power icon.

Activating MyPal

It is important that you properly calibrate and activate your device before
using it. This process ensures accurate positioning when entering text and
selecting menus.

Follow these steps to calibrate and activate MyPal.

1. Press the power button.

2. Use the stylus to tap the LCD touch screen to start the calibration and
activation.

3. At the prompt to align the screen, tap the center of the cross whenever
the travelling cross stops on the screen. You may have to do this step
several times to properly calibrate.

4. When done with the screen calibration, follow the screen instructions to
complete the activation.

« atthe “Stylus” screen, tap Next to continue.
« atthe “Pop-up menus” screens, perform the indicated operations.
« atthe “Congratulations” screen, tap Next to continue.

« atthe “Location” screen, select your time zone and tap Next to
continue.

« atthe “Completion” screen, tap the screen to continue.

5. When the Today screen appears, MyPal is ready to use. Proceed to
the next section for information on the basic screens on your device.

1-10 Chapter 1

Download from Www.Somanuals.com. All Manuals Search And Download.



Basic screens on MyPal

Today screen

Normally, the Today screen appears when you turn on your device for the
first time each day.

NOTE When the device is already on and the screen displays
another program, you can display the Today screen by

icon. Then from the Navigation bar, tap

tapping the
Today.

As shown in the sample below, the Today screen lets you see at a glance
the summary of the important information for the day.

Tap to set up or change network or modem connections
Tap to change volume or mute all sounds

Tap to switch
to a program

Tap to display the date, time,
and your next appointment

Tap to change the date and time

Wednesday, July 09, 2003

Owner: Blanche Rosewell
(B86-2) 2890-7811

Your day at a glance

Tap to create a new item Tap to display the Bluetooth menu

Tap to view PC connection status

From the Today screen, tap any of the listed items with the stylus to
display the details. See “Chapter 2: Learn the basics” to learn how to
modify the current tasks or activities, or to add new items or information.

Get started! 1-11
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Start menu

From the Start menu, you can select programs, settings, and Help topics.

To display the Start menu, tap the

& icon from the top of the screen.

Tap to open a recently used program

Tap to open a program

Tap to open the Programs menu
Tap to open the Settings menu

Tap to display the Help topics

Program Description

ActiveSync Synchronize information between your
device and your desktop computer.

Calendar Keep track of your appointments and create
meeting requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail messages.

Internet Explorer

Browse Web and WAP sites, and download
new programs and files from the Internet.

@@@ﬂjmim@“ Il L_H@g

Notes Create handwritten or typed notes, drawings,
and recordings.

Tasks Keep track of your tasks.

Programs Tap to see additional programs installed in
your device.

Settings Tap to see items that you can customize or
adjust to your preference.

Find Tap to find data in your device.

Help Tap to see the Help contents.

1-12
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Command bar

At the bottom of the screen is the Command bar. You can use the menus

and buttons on the Command bar to perform tasks in programs.

NOTE

The menus and buttons vary depending on the programs you

are using.

New Edit Tools [ #

=~

[
Tap to select menu

commands

Pop-up menus

With the pop-up menus, you can easily choose an action for an item.

For example, you can use the pop-up menu in Tasks to delete, copy, or
beam a task. The actions in the pop-up menus vary from program to
program. To access a pop-up menu, tap and hold the stylus on the item

Tap to select
button commands

' |
Tap to display
the input panel

that you wish to perform action on. When the menu appears, lift the stylus,

and tap the action that you want to execute. To close the pop-up menu

without performing an action, tap anywhere outside the menu.

All Tasks «

Priority -

| ! | L ” Tap here to add a new task

]! Fileincome tax

Arrange documents,/pictures
Buy gift for Chloe

Call Edwin

Meet w/ Brian

"o - T inyoices
Create Copy

il
[
1]
1]

Delete Task

Beam Task...

Tap the action that you wish to perform

— Tap outside the pop-up menu to close it
without performing an action

Mew Tools

VA

Get started!
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The pop-up menus are also available in most other programs in your
device. The pop-up menu items vary depending on the program or
application. For example, the File Explorer pop-up menu includes more
items than in Tasks.

&v??. File Explorer

My Documents « Name |

[ Annotations -
[ Business ]
=3 My Pictures ]
= Personal

) Templates

Tap outside the pop-up menu to close it
without performing an action

Tap the action that you wish to perform

Delete

Send via E-mail...

Beam File... .
7 —— Tap and hold until the pop-up menu appears

ah?N-f Lifilores 2 | L

IEdlI: Dpe_n|* [!] | Z|‘
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Entering information

You can enter information in your device in any of the following ways.

» Use the input panel to enter text using the soft keyboard or the Letter
Recognizer

« Write directly on the screen with the stylus

» Draw pictures on the screen

» Speak into the device microphone to record a message

» Use the Microsoft® ActiveSync® to synchronize or copy information from
your desktop computer to your device

Entering text using the Input Panel

Use the Input Panel to enter information in any program on your device.
you can either type using the soft keyboard or write using the Letter
Recognizer, Block Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your options.

& 4291
e

Block Recognizer
* Keyboard Select an input method

Letter Recognizer
Transcriber

New Edit Tools [= EE

Tap to display the input method options

Tap to show or hide the input panel

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button, then tap Keyboard.

NOTE To demonstrate, open Notes.

2. Tap the keys with the stylus to enter information.

2-2 Chapter 2
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When you use the Input Panel and the soft keyboard, your device

anticipates the word you are typing and displays it above the Input Panel.

When you tap the displayed word, it is inserted into your text at the

insertion point. The more your use your device, the more words it learns to

anticipate.

NOTE

& 421001 D

Market re -
|research|
123(1[2[3]a][5]6|7]|8]0]0]-[=]«
Tab[a[wle[r[t|¥[ufifo][p[[]]
caPlafs[afffa[n]ilk]1]:]"]
shift| z[x |[c[v[b[n[m[,[.][/]+
culaa]” [\ ] [¢[t]e]>
New Edit Tools & |~

Tap here if this is the word you wish to use

To change options on word completion feature:

Tap .

Tap Settings.
Tap Personal tab.
Tap Input.

ocoubkwpE

To use Letter Recognizer:

With the Letter Recognizer, you can write letters on the screen with the

stylus as you would on paper.

1.

Learn the basics
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Tap Word Completion tab.
Make your desired changes.

Tap the arrow next to the Input Panel button, then tap Letter
Recognizer.

Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Letter
Recognizer, tap the question mark next to the writing area.



To use Block Recognizer:

With the Block Recognizer, you can input character strokes that are similar
to those use on other devices.

1.

Tap the arrow next to the Input Panel button, then tap Block
Recognizer.

Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Block
Recognizer, tap the question mark next to the writing area.

To use Transcriber:

With Transcriber, you can use the stylus to write anywhere on the screen
as you would on paper. Unlike Letter Recognizer and Block Recognizer,
you can write a sentence or additional information. Pause after writing and
let Transcriber convert the written characters to typed characters.

1. Tap the arrow next to the Input Panel button, then tap Transcriber.
2. Write anywhere on the screen.

For instructions and demonstration on using Transcriber, with
Transcriber open, tap the question mark in the lower right corner of
the screen.

To edit typed text:

1.

2.

2-4

Select the text that you wish to edit using either one of the following:

« drag the stylus over the text
+ tap twice to select a word
 tap three times to select a paragraph

Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.

Chapter 2
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Writing on the screen

In any program that accepts writing, such as the Notes program, and in the
Notes tab in Calendar, Contacts, and Tasks, you can use the stylus to
write directly on the screen. Write the way you do on paper. You can edit
and format what you have written and convert the information to text at a
later time.

To write on the screen:

1. Open the Notes program.

2. Tap the Pen button to switch to the writing mode. The screen displays
blank space with lines to help you write.

3. Write your text.

=
MNew Edit Tools = E|A

L Tap the Pen button and use
your stylus like a pen

NOTE Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.

Learn the basics 2-5
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To edit your writing:

1. Tap and hold the stylus next to the text that you wish to select until the
insertion point appears.

2. Without lifting, drag the stylus across the text to select it.

If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping the Pen button to deselect it,
then dragging the stylus across the screen.

3. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.

To convert writing to text:

« Tap Tools, then Recognize.

To select a zoom level:

« Tap Tools, then tap a zoom percentage from the options.

& 4f11:00 D

E fﬁ L Financial audit

j Send via E-mail...

Beam Mote...

T5%

100%
150% E—

* 200%
300%

Rename;/Move...

Delete Note

New Edit|Tools| = E|“ New Edit Tools [=1 E|A

-

4]

The writing is turned into text
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing.

1.

Tap and hold the incorrect word.

2. When the pop-up menu appears, tap Alternates to display a list of

alternate words for the selection.

Tap the word that you want to use, or tap the writing at the top of the
menu to return to the original writing.

& o2 1037 (D

W?:_I/MA &/c/ f‘% tL Tap to return to your

original writing

financial
Financial
financlal Or, tap the word that
you want to use

financIAL —
financial
financlal
financial
financlal

financlaL

-

New Edit Tools (= 7 E|A

Tips for getting good writing recognition

Write neatly.

Write on the line and draw descenders below the line. Write the cross of
the “t” and apostrophes below the top line so that they are not confused
with the word above. Write periods and commas above the line.

For better recognition, try increasing the zoom level to 300% using the
Tools menu.

Write the letters of a word closely and leave big gaps between words so
that the device can easily tell where the words begin and end.

Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.

If you add writing to a word to change it after the word has been
recognized, the writing that you added will be included when you try to
recognize the writing again.

Learn the basics
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Drawing on the screen

You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.

To create a drawing:

1. Use the stylus to make a stroke three ruled lines high. A dotted box
appears.

2. Make your drawing in or touching the drawing box and crossing three
ruled lines. If the drawing does not cross three lines, it changes to writing.

& 42 1029 (D

Dravri 1)
The drawing box indicates the
— .| boundaries of the drawing
Mew Edit Tools = E|*
I— Pen button
NOTE To easily work on or view your drawing, change the zoom

level by tapping Tools and selecting your desired zoom.

To edit your drawing:

1. Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button, then
drag to select the drawings you want.

2. Tap and hold the selected drawing, then tap an editing command on

the pop-up menu or tap a command on the Edit menu.

3. Resize the drawing by deselecting the Pen button (if selected) and

2-8

dragging a selection handle to your desired size.
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Recording a message

In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to
include the recording in a note, open the note first. In the Inbox program,
you can add a recording to an e-mail message.

To create a recording:

1. Hold your device with the microphone near your mouth or other source
of sound.

2. Press and hold the Record button on the device until you hear a beep.

3. While holding the Record button, make your recording.

4. To stop recording, release the Record button. You will hear two beeps.
The new recording appears in the Note list, or as an embedded icon.

NOTE You can also make your recording using the buttons on the
Recording toolbar.

5. To play the recording, tap it from the list, or if embedded in a note, tap
the speaker icon.

£iF |Notes & g 1144 D

@ = Indicates an embedded
recording

Birthday greeting

for Kirsten Chloe

-

|
o[m)) || m|ut

New Edit Tools |IE||IZ| £|A
L Tap to show or hide the

Recording toolbar

Tap to begin recording
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To change the recording format

1. In the note list, tap Tools then

Options.
2. Tap the Global Input Options link.
Tap the Options tab.

M_ob|le Voice is a 2.4KB audio codecC. | ... .comlevel for mrting:
It is the recommended format because | o . zoomlevel for typing:

it provides good voice recording and
less storage space.

Pulse Code Modulation (PCM)
provides slightly better sound quality
but takes up 50 times more storage
space tham Mobile Voice recordings.

Using a preset message

l.fly Settings

Input

These options apply when writing or
recarding is supported.

‘oice recarding Format:

Capitalize: first letter of sentence
Scroll upon reaching the last ling

Input Method | wiord Completion | Cptions

If stylus taps become inaccurate, alignthe
touch screen.

E|“

When using Inbox or MSN Messenger, use My Text to quickly insert
preset or frequently used messages into the text entry area. To insert a
message, tap My Text and tap your desired message.

NOTE You can add text after inserting a My Text message.
However, you have to add it before sending the message.

To edit a preset message:

1. Tap Tools, then Edit My Text Messages.
2. Select a message and make your desired changes.

& 421154 €3
Inbox « Subject -
Empty Deleted Items
Edit My Text Messages...
Status...
Inboy Dptions...
New Tools| Accounts Bl &= E|‘
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My Text Messages

Tap a message, then edit below,

Yes. -
Mo,
Tharks, =
Please call rmy mobile.

I'l be right there,
I'mn running late, -

Please call my assistant., -

1z3l1[2]3]a]s]a]7]a]o]o]-[=]«

Tablg|wle|r[t|y[ulifo[p|[]]
caP[as[d[fla[n]ilk[1]:]"]
shittfz[x]c|y[b[n[m], [.[/]+
ctjai] " [\ ] [4]1]<]=
=8
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Finding and organizing information

The Find and Help features on your device helps you quickly locate

information.

To find information:

Tap & | then tap Find.

Enter the text that you want to find, select a data type, then tap Go to
start the search. To quickly find information that is taking up space on

your device, select Larger than 64 KB in Type.

Type a word to find

& 451210 €3

Find: password - [;:)

Type: Al data -| @a
Results
e Password
Help 2/28/03 253KB
e Protect Device Information
Help 2/22/03 246KB
123l1][2[3[4|s5]6[7]a]olo]-][=]«

Tabjafwle|r[t[y|ufifo[p[[]]

caplafs[alflaln]j[k[1];]"
shift[ z[x[c[v][b[n]|m]|

P

ctlai] " T ]

4]
[+]1 ]

[

2

To use the Help feature:

1. Tap &, then tap Help.

2. Tap alink to the topic that you wish to

display.

Learn the basics

— Tap to search for the word

Topics found containing
the searched word

o oL 12:42

[

Help Contents

ActiveSync
ASLIS Backup
ASLS Settings

i
[
=
=
[
=k
]
=
1]

Pocket Excel

Pocket Internet Explorer
Pocket PC Basics

view Find &
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Using the File Explorer

To use the File Explorer to find and organize files:

1. Tap ki, then tap Programs.

2. Inthe Program screen, tap the File Explorer icon to display the files in
your device.

fr'}' File Explorer &3 o€ 240 9
My Device -
=1 ConnMagr

(%] Flash Disk

=1 My Documents
= profiles

=1 Program Files
(%] Storage Card
= Temp

1 Windows

Tap to display sort options

— Tap to select a sort order

Edit Open |+ [[]] M S =R
L

Tap to display the contents of the
Flash disk or the storage card

Tap to display the contents of My Documents folder
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Customizing your device

You can customize your device by adjusting the settings, using the built-in
programs, and installing additional software.

Adjusting settings

You can adjust the device settings to your preference.

To see the available options:

1. Tapt=d, then tap Settings to display the Settings screen.
2. Tap the Personal or System tab on the bottom of the screen.

: £F|settings % ¢ 2:30 €3
E = & & B
Buttons Input Menus About ASUS Backlight
Settings
o &
Owner Password  Sounds & Certificates Clock Memory |=
Information Motifications
@
A
Today Power Regional Removye
Settings Programs
B o 0
-
Personal | System ‘ Connections | Personal | Syskem | Caonnections ‘
ds £+

You may want to adjust any one of the following items.

Clock. Change the time or set alarms.

Menus. Customize what appears on the £ menu, and enable a pop-up
menu from the New button.

Owner information. Enter your contact information.

Password. Add security to your device.

Power. Display the remaining battery power indicated by a bar chart.

Today. Customize the look and information displayed on the Today
screen.

NOTE Refer to the section “ASUS utilities” later in this chapter for
details on the bundled ASUS programs.
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To change the date and time settings:

1. Tap Settings, then the System.

2. Tap the Clock icon.

3. Make your desired settings.

l.y'_f}"j’ Settings

.12, GMT+8 Taipei

- —]

1:12:05 &M

R
(i e

5 f23/2003 -
May 2003

[ ]
W T F S

(O Visiting | 2——
il
{11 12 13
T |12 19 20
ol |25 26 27
e

Today: 5/23/03
Time | Alarm T ¥: 5/23/

01 2 3
7 8 9 10
14 15 16 17
21 22 PEEg 24
28 20 20 31
4 5 6 7

Tap to select a time zone

|+|+ ——— Highlight a Time item then

tap up or down arrow to set

Tap this down arrow to
display the Calendar

E|‘.

To change the alarm settings:

1. Tap Settings, then the System.
2. Tap the Clock icon, then the Alarm tab.
3. Make your desired settings.

Tap a day of the week for the alarm

Tap and type a description for the alarm

— Tap to display the clock and

specify a time for the alarm

£iF|settings e 42 224 D

[« Clescription = W
SEETW TFS 6:00 AM o

|:| < Description = e
sMTwTFsS £:00 AN

[] « Description » I
sMTwTFS £:00 AN

|:| « Description = e
st wTFsS £:00 AM

Time | Alarms |
Edit £|‘
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Selecting sounds and notifications

Your device can remind you of things you have to do in several ways. For

example, if you have set up an appointment in Calendar, a task with a due
date, or an alarm in Clock, you will be notified in any of the following ways.

A message box appears on the screen

A sound is played (you can select the type of sound)

A light flashes on the device

To choose the reminder types and sounds:

1. Tap t=i icon then tap Settings.

2. From the Settings screen, tap the
Sounds and Notifications icon to

3.

display the Volume screen.

Adjust the items to your desired

settings.

Tap the Notifications tab and set the

event notification details.
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Sounds & Motifications

System volume
Silent:

Loud

i
b

Enable sounds for
Events {warnings, syskem events)

Programs

Motifications (alarms, reminders)
D Screen baps

Soft O Loud
D Hardware buttons
O Soft Lowd

olume ‘ Motifications |

2|

& fz 820 (D

&13’ Settings

Sounds & Motifications

1, Select an event

erminders
2. Select how to be notified
Ply sourd
[ ] Repeat III IEI

Display message on screen

Flash light for

Wolume | Motifications

2|
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Using ASUS Launcher

This program allows you the convenience of classifying your frequently
used programs, and quickly launching them with just a few taps.

To access ASUS Launcher:

1. Tap =4, then Programs.
2. Tap ASUS Programs, then ASUS

2-16

Launcher.

NOTE To quickly access ASUS

Launcher, press the 3%
button (leftmost) on your
device.

From the command bar, tap £igl|Favorites & g1
Name to display the names of the %’f
existing categories. il o

The default categories are L sk
Favorites, Start Menu, and
Programs.

Tap a category to display the
programs it contains.

By default, the Favorites category

contains the ASUS Launcher and %
ASUS Backup program icons. Programs

Category | Mame I Editor

NOTE You cannot delete the default categories. However, you may
edit the default titles, and add or delete programs contained
in these categories.
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5. Tap Start Menu or Programs to display the default programs in them.

L.Ew'ri Start Menu o o 927 @ L.f?'ri Programs oF ot 927 @
— i = = -

® € B
Bluetooth  Windows Tasks AsusLaunc.., ASLIS Terminal
Manager Media Backup Services

ads @

@ D @ r 20 %
Internet Motes ActiveSync Microsoft  Jawhbreaker icon =
Explorer Reader

Inbos Contacts Calendar Solitaire  File Explorer  Calculator

¥ & P
Pocket MSM MSH Pictures
Messenaer &
Category | Name | Editor Category | Name | Editor
NOTE Whatever category is selected, that category will be launched

the next time you tap the AsusLauncher icon.

To edit the name of a default category:

1. Tap Name, and select a category that you wish to rename. For
example, Programs.

2. Tap Category, then Edit Title.
3. Inthe Edit Current Category screen, revise the name.

4. Tap OK.
L-E’? Favorites & 21211 @ / ‘!" i i, F
; &
[My Favorites ) |
ASLIS ASLIS
Launicher Backup

12312 (|3|4|5]|6|7[8]0|0]-|=|«
Refresh Tab[q[wle[r[t][¥Juli]o]p|L]]
= capla] s [al7]aln]3[k[1];]"

shitz[x]c[¥][b]n]m].]. +

LT
Delete culai] " [\] [4]t]«]=

Category| Mame | Editor =

g
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To customize an existing category:

Programs

2-18

Tap Editor, then Copy To.

Tap Name, then Programs (or
Start Menu).

In the Programs screen, tap the
program icon that you wish to
copy. For example, Jawbreaker.
A pop-up screen appears.

Select a target destination for the
program icon. For example,
Favorites.

Repeat steps 3 and 4 to copy
other programs that you wish to
launch often.

When done, tap Copy To then
Launch to return to the launch
mode.

Tap Name then Favorites to
display your customized quick
launch programs.

Tap OK to set Favorites as your
quick launch category.

The next time you access
AsusLaunch, the Favorites
category appears.

& £ 11:26

AsiLisLa nal

Solit

¥ & P

Pocket MSH MSH Pictures
Messenger

Category | Name | Copy To

.E‘? Favaorites

3 ol

Jawhreaker Solitaire Fictures

3

MSH Calculator
Messenger

Start Menu
My Programs

& 421235 (D

Category | Mame : Editor
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To remove programs from a category:

Tap Editor, then Remove.

Tap Name, then any of the
existing categories.

Tap the program icon that you
wish to remove. For example, the
Calculator icon in the Favorites
screen.

The icon disappears from the
screen as soon as you tap it.

When done, tap Remove then
Launch to return to the launch
mode.

Tap OK to save your changes.

To add a new category:

1.

Tap Category, then Add. A new
category is automatically added.

Tap Name to see the updated list
of categories.

If you wish to rename the new
category, se page 2-17 for
instructions.
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& 2 12299 (D

3 o

Jawhreaker Silitaire: Pictures

4 S
i)

MSH Calculator
Messenger

l.f;? Favaorites

Move To
v Remove

Launch

Category | Name |

Start Menu
Programs

v Category 3

Category | Name : Editor
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Adding or removing programs

Programs added to your device at the factory are stored in ROM (Read-
Only Memory). You cannot remove this software, and you will never
accidentally lose ROM contents. ROM programs can be updated using
installation programs with a *.xip extension. All other programs and data
files added to your device after factory installation are stored in RAM
(Random Access Memory).

You can install any program created for your device, as long as it has
enough memory. The most popular place to find software for your device is
on the Pocket PC web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync:

NOTE You need to install the Microsoft ActiveSync on your desktop
computer before you can synchronize and/or add programs
to your device. Refer to “Chapter 3: Microsoft ActiveSync” for
installation instructions.

1. Determine your device and processor type so that you know which

version of the software to install. Tap i , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your desktop computer (or insert the CD that
contains the program into your desktop computer). You may see a
single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of
files for different device types and processors. Be sure to select the
program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Connect your device to your desktop computer.
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5. Double-click the *.exe file.

 Ifthe file is an installer, the installation wizard begins. Follow the
directions on the screen. Once the software is installed on your
desktop computer, the installer automatically transfers the software to
your device.

« Ifthe file is not an installer, you will see an error message stating that
the program is valid but it is designed for a different type of computer.
You need to move this file to your device. If you cannot find any
installation instructions for the program in the Read Me file or
documentation, use ActiveSync Explore to copy the program file to
the Program Files folder on your device. For more information on
copying files using ActiveSync, see ActiveSync Help.

6. When the installation is complete, tap =2 , Programs, and the program
icon to switch to it.

To add a program directly from the Internet:

NOTE You need to be connected to the Internet through an optional
modem card or network card before you can add programs
directly from the Internet.

1. Determine your device and processor type so that you know which

version of the software to install. Tap k=4 , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your device straight from the Internet using
the Pocket Internet Explorer. You may see a single *.xip, *.exe, or
*.zip file, a Setup.exe file, or several versions of files for different
device types and processors. Be sure to select the program designed
for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard begins.
Follow the directions on the screen.
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To add a program to the Start menu:

1. Tap i, tap Settings, tap Menus, tap the Start Menu tab, and tap the
check box for the program. If you do not see the program on the list,
you can either use File Explorer on the device to move the program to
the Start Menu folder, or use ActiveSync on the desktop computer to
create a shortcut to the program and place the shortcut in the Start
Menu folder.

2. If you are using the File Explorer on the device:
a. Tap =&, tap Programs, tap File Explorer, and locate the program

(tap the folder list, labeled My Documents by default, then tap My
Device to see a list of all the folders on the device).

b. Tap and hold the program, then tap Cut on the pop-up menu. Open
the Start Menu folder located in the Windows folder, tap and hold a
blank area of the window, then tap Paste in the pop-up menu.

c. The program now appears on the i menu. For more information on
using the File Explorer, see the section “Finding and organizing
information” earlier in this chapter.

3. If you are using ActiveSync on the desktop computer:

a. Use the Explorer in ActiveSync to explore your device files and locate
the program. Right-click the program, then click Create Shortcut.

b. Move the shortcut to the Start Menu folder in the Windows folder. The

shortcut now appears on the 22 menu. For more information, see
ActiveSync Help.

To remove a program from the Start menu:

1. Tap i, then tap Settings. On the System tab, tap Remove
Programs.

2. If the program does not appear in the list of installed programs, use
File Explorer on your device to locate the program, tap and hold the
program, then tap Delete on the pop-up menu.
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ASUS utilities

Besides the Microsoft program that allows you to back up data, your
device also includes proprietary ASUS utilities. The ASUS utilities allow
you to backup or restore data, and adjust settings to customize your
device and maximize its use.

ASUS SmartKeeper

The ASUS SmartKeeper is an automatic backup feature that prompts you
to backup the current system status in a CF memory card whenever the
remaining battery power reaches a certain level. With the automatic
option, the backup process is done whether the device is ON or OFF as
long as a CF memory card is present in the slot.

Requirements for automatic backup

« SmartKeeper is enabled
» a CF memory card in the card slot (64MB free space recommended)
 the remaining battery power in the device reaches a low level

To enable automatic backup:

1. Tap B, then tap Settings. Bjsciimes ki @
2. Tap the System tab on the bottom of About ASUS  Backlight [

Settings

the Settings screen.

3. Tap the SmartKeeper icon then the

i Certificates Clock Memory
Automatic tab. )
H @
Power Regional Removye

Settings Programs

Learn the basics
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4. Inthe Automatic screen, check the
Automatic system backup box to
enable automatic backup. This box is
checked by default.

When SmartKeeper is set to
Automatic, make sure that a CF
memory card (64MB free space
recommended) is present in the CF

SmartKeeper

Automatic systern backup

Check the '&utomatic system
backup' box to automatically
back up the current system
status to ASUSBELIP,SAY file
when the battery power is low,

card slot.
5. Tap OK.
Storage Device | Automatic | Manual
iz
NOTE To verify if the CF memory card is usable for system backup,

perform a Manual backup first. See the section “To use

manual backup” on page 2-27.

How the SmartKeeper automatic backup works

SmartKeeper is capable of performing the automatic backup process
whether your device is in use (ON) or in suspension (OFF).

When the device is ON

If a low battery status occurs while you are using the device, this message
appears, “Battery low! Back up the current system status?”

Backing up the “current system status” means that the entire
system and all the data in the system main memory are saved as
is to the ASUSBKUP.SAV file. For example, you are editing an
Excel file when a battery low status occurs and you confirmed to
back up. When you restore the system status from the
ASUSBKUP.SAYV file, you will see exactly the same screen,
settings, and system configuration as earlier backed up.
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To back up the current system status:

1. When prompted, tap the Yes
button on the screen message
window to start the backup
process.

a.

If you set Flash Disk as your
storage device, SmartKeeper
saves your current system
status to the file
ASUSBKUP.SAV in the Flash
Disk. This is a 32MB storage
space in the device Flash
ROM.

NOTE Flash Disk is the

b.

default setting.

If you set CF Card as storage
device, the backup file is
saved in the CF card. Make
sure that a CF memory card is
present in the slot. If you tap
Yes without the CF memory
card, an error message
appears.

Tap No if you do not wish to
back up the system status at
this time.

2. A confirmation message appears
when the backup process is
complete.
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SmartKeeper

r5torage Device

search for backup file storing the
saved systern status,

(@) Flash Disk
) CF Card

Select the storage device, which is
used to store the backup file and to

Apply

Storage Device | Aukammatic | Manual ‘

E|A

SmartKeeper

e CF rmemory card not ready!

SmartKeeper

ok

& Backup complete.
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When the device is OFF

When a low battery status occurs while the device is in standby or OFF,
SmartKeeper wakes up the system to back up the system status.

» Ifyou selected Flash Disk as your storage device, SmartKeeper
automatically backs up the system status to ASUSBKUP.SAV file in the
Flash Disk.

» Ifyou selected CF Card as your storage device:

1. SmartKeeper checks if a CF memory card is ready in the slot.

2. If found, SmartKeeper backs up the current system status to
ASUSBKUP.SAV file in the CF memory card. When the backup
process is complete, the system automatically goes back to sleep
(OFF).

If a CF memory card is not ready in the slot, the device goes back
to sleep without performing the backup process.

When you turn on the device, either one of the following messages is
flashed on the screen.

power low status. The system
status was automatically backed
up to ASUSBKUP.SAYV file in the
CF memory card.

The system detected a battery If automatic backup failed because

power low status and tried to a CF memory card is not ready in

back up the system status at the slot
2003/04/08, 10:21:27 AM. Backup
failed! CF memory card not ready.

The system detected a battery If automatic backup failed because
power low status and tried to the CF memory card in the slot

back up the system status at :
2003/04/08, 10:21:27 AM. Backup may be defective and not

failed! Cannot access CF memory accessible
card.
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The system detected a battery
power low status and tried to
back up the system status at
2003/04/08, 10:21:27 AM. Backup
failed! Insufficient space in the
CF memory card.

The system detected a battery
power low status and tried to
back up the system status at
2003/04/08, 10:21:27 AM. Backup
failed! System error.

To use manual backup:

1.

Tap 1 , then tap Settings.

2. Tap the System tab on the

To restore the system status:

H w e

bottom of the Settings screen.

Tap the SmartKeeper icon, then
the Manual tab.

Tap the Back up system button
to back up the current system
status to ASUSBKUP.SAV file in
the CF memory card.

A message appears to confirm
that the backup process is
complete.

Tap ¥ , then tap Settings.

If automatic backup failed because
the available space in the CF
memory card is not enough to
back up the current system status

If automatic backup failed because
a system error occurred.

Smartkeeper

| Back up system |

| Restore system |

Tap the Back up systern’ button
to back up the current system
status to ASUSBELP, SAY file,

Tap the 'Restore systermn’ button
to restore the saved system
status from the ASUSBELIP.SAY
file.

Storage Device ‘ Aukomatic | Manual

|~

SmartKeeper @

& Backup complete.

Tap the System tab on the bottom of the Settings screen.
Tap the SmartKeeper icon, then the Manual tab.

Tap the Restore system button to restore the saved system status
from the ASUSBKUP.SAV file in the CF memory card.
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SmartKeeper error messages

When backing up or restoring the system status, you may receive any one
of the following error messages. The messages tell you the reason why
the error occurred.

Back up Restore
SmartKeeper SmartKeeper
Backup falled! CF memory Backup file ASUSEKLUP SAV
card not ready. not found in CF mermnory
card!

SmartKeeper SmartKeeper
access CF memory card, gg;‘fﬁ:;‘:‘t match this

SmartKeeper

Smartkeeper
e Backup failed! Insufficient Backup file ASUSEKUP,S&Y
space in CF memory card, does not match the ROM

varsion of this devicel

SmartkKeeper

Smartkeeper

Backup failed! System
Errar, 0 Backup file ASUSEKUP.SAV

Corrupted!

Smartkeeper @
0 Systerm errarl
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ASUS Backup

The ASUS Backup utility lets you back up your system files and/or data
contained in the main system memory. Unlike the ASUS SmartKeeper
automatic backup feature that backs up the entire system status (system
and data) into one backup file, this utility allows you to manually create
separate backup files for your system files and data files. You may even
categorize the data files and place into different folders.

To access the ASUS backup utility:

1. Tap =i, then tap Programs.

To stop all running programs:

1.

& %
ASLS

Tap eogams , then tap o .

A message appears asking you to
stop other programs before
running the backup utility.

Tap OK and stop all running
programs.

Tap 1 , then tap Settings.

2. Tap the System tab, then tap the

Memory icon.

On the Memory screen, tap the
Running Programs tab.

Tap the Stop All button, then tap
OK.

Learn the basics
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ASUS Backup

Please stop other programns
before running backup
Litility,

Memory

Running Program Lisk:

Marme
Motes
ActiveSync
14 Alburm
File Explorer

| Activate | | Stop | | Stop All |

Main | Storage Card | Funning Programs

Remove programs to free storage memory,
Find large files using storage memory,

E|‘
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NOTE See the online help on your device for online instructions to
back up or restore data.

To back up all data on your device:

£3 |asus Backup o e 327 (D

1. Return to the ASUS programs
IZlick ‘&l Data' button to backup all data or
screen and tap the ASUS 'PIM Data' button to backup PIM data.
Backup icon.

2. Tap the Backup tab on the ASUS
Backup screen.

3. Tap All Data button to back up all PIM Data
data on your device.

Bytes to backup: ~30863 KB

All Data

Information ‘ Backup | Restore |

]
NOTE You need to insert a CF memory card into the CF slot if you
wish to save your backup file into a removable storage
device. Otherwise, you can save the backup file into the
Flash Disk.
4. Inthe Backup File screen: ff|nsusBackup & 4¢ 1036 €
* specify a file name for the Backup File
backup File: |h|an|:he v|
« specify the folder in which to Foder:  [Nore <]
store the backup file (optional) Loc: [Flah DEk =
+ select the storage device ok ] [Cancel |
(Flash Disk or CF card) where
you wish to save your backup AR AR e e
file Tabla[wle[r[t[y[ufi]o[p[I]]
capla[s[alf[a[h]j[k[I[:]"]
5. Tap OK to start the backup shit[z [x[c[v [b[n[m[, [. [/«
process. Ctlai] " [\ ] [4] ||?E|J3
2-30 Chapter 2
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6. The screen shows the status of the backup process. When done, a

7.

message appears indicating that the backup is complete, and shows
the total size of the backed up files.

In case the program fails to back up any items, it will show the items on

the screen.
Tap OK.

FiF|asus Backup A 4¢336 €@

Backing up:
Wy Docurnentslas20-11.brp

Bytes to backup: 31628203 Bytes

]

Backup faled iter] @

£F|asus Backup S 4337

Complete

Bytes to backup: 31628203 Bytes

Backup failed iterns:

To back up only PIM data on your device:

1.

On the ASUS Backup screen, tap
PIM Data button to back up only
the personal information
management (PIM) data on your
device.

Select the storage device (Flash
Disk or CF card) where you wish
to save your backup file.

Tapping Cancel returns you to the
previous screen.

Tap the Backup tab.

Learn the basics
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& 42 1036 €9

Storage Device
(@) Flash Disk

) CF Card

Cancel

Storage Device | Backup |
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4. Type a name for your backup file

7.

8.

2-32

and the folder where you wish to
place it. You may opt not to
specify a folder.

Check the boxes opposite the
items that you wish to back up, or
tap Select All to select all listed
items.

If you checked the box User
Defined Folders, tap Define to
specify the folders that you wish
to include in the backup file, then
tap OK.

Tap Start to begin the backup
process.

When the backup process is
complete, the screen displays the
message “Complete” and a list of
all the backed up items.

Tap OK.

343 €9

£ |asus Backup

-File Name
File: |juhnmark v|
Folder: |N|3ne v|
-PIM Select

Calendar Motes [w] Contacts
Yoice Tasks [w] Inbox

lUser Defined Folders

| Start ||Select AII” Cancel |

Storage Devices | Backup ‘

E|‘.

edé 344 €3

£ |asus Backup

Uset Defined Folders

Folder: Application Data

Selected:

! inciones
0K | | Cancel |
|-

% g 348 (D

#1¥|asus Backup

Complete

Calendar: Success
MHotes: Success
Contacts: Success
Voice: Success
Tasks: Success
Inbos: Success

Lzet Defined Folders: Success

E|“
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To restore all data:

1. Tapt=d, then tap Programs.

NOTE If you saved your backup file into a CF memory card, you
need to insert that CF memory card into the CF slot when
restoring data. Otherwise, you will receive the message “No

storage devices are found!”

2. On the ASUS Programs screen
Tap the ASUS Backup icon.

When prompted, stop all running
programs. See page 2-29 for
instructions.

3. Tap the Restore tab on the ASUS
Backup screen.
4. Tap All Data.

5. Inthe Backup File screen:

« select the backup file name
(tap the arrow to list down other
backup files, if any)

+ select the folder that contains
your backup file (optional)

» select the storage device
(Flash Disk or CF card) where
you stored your backup file

6. Tap OK to start the restore
process.

7. When the restoration is done, a
message appears prompting you
to reset the device.

8. Tap OK to reset.

Learn the basics

£ o € 4
£ | asus Backup ot 4447 (D

IClick 'all Data' button to restore all data or
'PIM Data' button to restore PIM data,

ote: After restored, some or all data wil
be replaced,

All Data

PIM Data

Information | Backup | Restore

|-
£F|asus Backup &t dtaar
Backup File

File:

Folder: |N|:|ne v|

Loc: |CF Card _|

| ok || cancel |

=~

ASUS Backup

Restoration is done, the
PDA s to be reset,,,
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To restore PIM data:

1. Onthe ASUS Backup screen, tap fglasusBackup  $F 4¢ 1036 €3
PIM Data. Storage Device

2. When prompted, select the (®) Flash Disk
storage device (Flash Disk or CF (O CF Card

card) where you stored your
backup file.

Tapping Cancel returns you to the
previous screen.

Cancel

3. Tap the Restore tab.

Storage Device ‘ Backup |

4. Select the backup file name (tap
the arrow to list down other i fiame
backup files, if any). File:

& oz 448 €3

£ |asus Backup

johnmark. bkp

5. Check the boxes opposite the Folder: — [ane 7|

items that you wish to restore, or
tap Select All to select all listed
items.

If you checked the box User
Defined Folders, tap Define to

-PIM Select
[]calendar [ ] Motes [] Contacts

[] woice [ Tasks [ ] Inbox
(] User Defined Falders

specify the folders that you wish e (oo [hewe
tO I‘eStOt’e, then tap OK Storage Devices | Restore |
|~

6. Tap Start to begin the restore
process.

7. When the restoration is done, a
message appears prompting you
to reset the device.

8. Tap OK to reset.

ASUS Backup

Restoration is done, the
FD& is to be reset...
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ASUS Settings

To access the ASUS settings:

1. Tap %, then tap Settings.

2. Tap the System tab on the
bottom of the Settings screen.

3. Tap the ASUS Settings icon to
display the system information
screen. This screen is displayed
whenever you tap the Info tab.

To change the Run Mode:

Tap the Mode tab to display the
running mode of the CPU.

The Turbo Mode allows better CPU
performance. In this mode, the CPU
speed goes up to 400MHz. Set to this
mode when playing games or playing
video. However, setting to Turbo
mode may reduce the battery life.

The Standard Mode allows for up to
300MHz CPU speed. Set to this
mode when listening to MP3 audio
files or for applications that do not
require very fast CPU speed.

& g3 D

ASUS Settings

-Version
ROM Date: 2003/0711
ROM Wersion:  W0.85.30 WwWE
05 Version: PocketPC 2003
Boot Version: 030425211445

rMemory
System ROM Size: 64MB
System RAl Size: 64MB
Lsable RAM Size: 55.2MB

Infa ‘ Made | Display | Audio ‘ REC | Wakel 4|k
|-

ASUS Settings

-Run Mode
{# Turbo Mode

) Standard Mode

) Pawer Saving Made

) Butomatic Maode

advanced Performance
Enhancemment

Infa | Made | Displaty | Audin | AiEC | Wakﬁl r
|-

The Power Saving Mode sets the CPU to a fixed speed of 200MHz. Set
to this mode when using text based applications such as Word, Excel, etc.
This mode has a lower CPU performance but extends the battery life.

The Automatic Mode allows for 200MHz, 300MHz, or 400MHz CPU
speed depending on the program that you are running.

Check the Advanced Performance Enhancement box to increase

system performance.

Learn the basics
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To change the Display settings:

1. Tap the Display tab.

2. Set the degree of brightness while
on battery power by tapping the
down arrow and selecting a

ASUS Settings

-Brighthess

O Battery Power:

oA

value, or by dragging the slider ' L
to the left or to the right until you On External Power:
achieve your desired brightness. S —

3. Follow step 2 to set the degree of
brightness when using external

power.
Info ‘ Mode | Display | Audio | BGC | Wakei 4| »
|-
NOTE Using a lower degree of brightness while on battery power

substantially reduces battery power consumption.

To change the Audio settings:

Tap the Audio tab to adjust the

volume, balance, treble, and bass ASUS Settings
Settings. -\fulume .
Drag the slider to the left or to the : 0 :
right until you achieve your desired -Balance
sound output. i e
Tap the Default button to restore the e
default audio settings. - Q, - 5 g
Info | Mode ‘ Display | Audio | AGC ‘ Wakei 1 ¥
|-
2-36 Chapter 2
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To change the Microphone settings:

Tap the AGC tab to adjust the
settings for the microphone sensitivity
and automatic gain control (AGC).

The AGC features allows you to
adjust the recording and environment
noise level.

« The MIC Sensitivity controls the
sound recording input. Setting the
slider toward the “+” sign allows for
a louder recording, but the
environment noise level may be
louder also.

« The Gain Control sets the sound
recording output.

To change the Wakeup Sources:
Tap the Wakeup tab to select the

source wakeup buttons.

Pressing any one of the checked
buttons wakes up the device.

The program assigned to a specific
button appears when you press that
button.

Tap 2 , Settings, and Buttons for
the button assignments. You may
customize the button assignments.

Learn the basics

<v g 312 (D

ASUS Settings
rM™IC Sensitivity
- +
rGain Control
{3 Manual 2 +
MIC Gain Contral: oo
() Automatic 5 +
Output Lewel: EI ' ! !
Load Default
Infa | Mode ‘ Display | Audio | A5 | Wak&l 11
|-

l.fly Settings

ASUS Settings

-Wakeup Sources

Record Button E
AP Button 1 £
AP Buttonz 3
AP Button s [E
AP Button 4

Maode ‘ Displaw | Audio | BGC ‘ Wakeup .C'EI
8
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To select Autorun Devices;

Tap the Autorun tab to select the £iF|settings

source devices to execute the ASUS Settings

autorun program, Autorun Devices
CF Card

Audio | AGC | ‘akeup | Autorun E‘I

|~
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Bundled programs

Your device includes the most common Windows programs and more.

To access the bundled programs:

l.f;? Programs

1. Tap &, then tap Programs. -
2. Tap any of the icons to launch a %2 G@ . II: |
specific application program. Pgrars e

wls
P ¥ B
File Explorer Microsoft MSM
Reader Messenger |=|
W E W
Pocket  Pocket Excel Pocket MSN
Word
2
Pictures Terminal —
SEervices
2|
ASUS Programs -
| BN |
Tapping the ASUS Programs icon S d
displays the ASUS Backup utility and || i
the ASUS Launcher. - )

Tap the ASUS Backup icon if you
wish to use the utility. See section
“ASUS Backup” on page 2-29 for
details.

Tap the ASUS Launcher icon to
quickly display your frequently used
programs.

Games £ |cames & 41045 @

@
Tap the Games icon to display the Jaw:;ker SD@E
available games.

|-

Learn the basics 2-39
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Calculator

Tap the Calculator icon to use the
calculator.

File Explorer

Tap the File Explorer icon to access
your files. See page 2-12.

Microsoft Reader

Tap the Microsoft Reader icon to
download and read online books.
See Chapter 5.

2-40

l.ﬁr?"j’ Calculator &+ g 10146 9

19621110.]

OM@@E)
(W E@©)E)
8(HOO®H®

" OROO®H
QRO

l.j?;"j’ File Explorer & £ 10:46 9

My Device - Name -

I Application D...
) ConnMgr

=) My Documents
IS profiles

|1 Program Files
%] Storage Card
= Temp

I Windows

Edit Dpen|* LIRE E|‘

12| i b oo
[*4) Y -
.f:i Microsoft Reader 4n (< 10:46 9

Library —

e Microsoft® Reader Help
e Microsoft Reader Team

Chapter 2
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MSN Messenger

Tap the MSN Messenger icon to use
the service. See Chapter 5.

Pocket MSN

Tap the Pocket MSN icon to get
connected to the Internet through the
Pocket Internet Explorer. See
Chapter 6.

Pocket Word

Tap the Pocket Word icon to create
Pocket Word documents. See
Chpater 5.

Learn the basics

l.i‘rr'rj' MSN Messenger & b1 9

Tap here to sign in w

msn*"

Messenger Service

Tools Chats E|*

l.irr'rj' Internet Explorer 1-':;¢ o= 2:78 9
file: f P windoees pocketrmsn.htm - .f’|>

ms,"!,‘ Mew! Pocket MSN

Subscribe now to get popular MSMN

services on your Pocket PCI

A& MSN Messenger® - Available wirkually
anywhere,
MSM Hobmail - Stay current! Manage
e-mail messages online and offline.
Alerts - Get personalized alerts about
weather, traffic, news, sports and more!

w! Mobile Web - Content at your
fingertips, on the go.

Tap iContinue For online pricing, availability and

device requirements.

*supports Exchange Inskant Messaging.

view Tools ¢ &%) & <& £|‘

£i3 |Pocket word & {2 1047 €
|= Templates + Mame
Blank Document 4/1/03 (1]1]
@] Meeting Notes 4/1/03 2k
& |Memo 4/1/03 2k

) Phone Memo 4/1/03 2k
4/1/03 3k
MNew Tools E|*
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POCket Excel l.j?;"j’ Pocket Excel & o 10047 9

= Templates + Mame
Tap the Pocket Excel icon to create [ ]vehicle Mileage L... 4/1/03 7k
spreadsheet documents. See
Chapter 5.

New Tools E|‘
Pictures

My Pictures « Name «
Tap the Pictures icon to view .jpg . a8 =
pictures stored on your device or on Eﬁ 3 ﬁ

A Peaceful Time & Quiet Ewening Ashley's Cottage

a storage card. Refer to the online
help on your device for details on H - E
using this feature. : ﬁi |

Auturnn Lane  Blozsorn Bridge Braokside
Hideaway
el B
Cobbelstans Ewerztt's Garden of
Braoke Cottage Prayer
s s R T
-
Tools TJ | E|‘

Terminal Services Client

Tap the Terminal Services Client icon I |
to connect to a terminal server. Refer Recent servers:

to the online help on your device for
more information.

Connect

[ Limit size of server desktop to fit
12371]2[3]a[5][6[7[8]9]0]-]=[«
Tablq[wle[r [ty uli[o[p[L[]]
caPla[s[d[fa[h[i[k[1];]"

shift[ 2 [x [c[v[b[n[m][, [.[/[+
ctlada]” [\] [4[t]e]>
=l
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Introduction

What is ActiveSync®?

The Microsoft® ActiveSync® is one of the important bundled programs in
MyPal. With ActiveSync, you can synchronize the information on your
desktop computer with the information on your device. Synchronization
compares the data on your device with your desktop computer and
updates both computers with the most recent information.

For example:

Keep Pocket Outlook data up-to-date by synchronizing your device with
Microsoft Outlook data on your desktop computer.

Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer. Your files are automatically converted to
the correct format.

NOTE By default, ActiveSync does not automatically synchronize all
types of information. Use the ActiveSync options to turn
synchronization on or off for specific information types.

With ActiveSync, you can also:

Back up and restore your device data

Copy (rather than synchronize) files between your device and desktop
computer

Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose to synchronize.

Select which information types are synchronized and control how much
data is synchronized. For example, you can choose to synchronize your
appointments of the past two weeks only, appointments older than two
weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.
2. From the Activesync menu bar, click Help then on Microsoft

3-2

ActiveSync Help.
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Installing ActiveSync®

The ActiveSync program is already installed on your device. To
synchronize information on your device with your computer, you must also
install ActiveSync on your computer. Install ActiveSync from the
Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that
you have Microsoft® Outlook® installed on your computer. If
you do not have Outlook, install the Microsoft® Outlook® 2002
from the Companion CD. Even if you have Outlook 98 or
Outlook 2000 installed, you are encouraged to update to
Outlook 2002.

Installing ActiveSync® on your computer

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

NOTE Do not connect your device to your computer until you have
finished installing ActiveSync.

2. Insert the Companion CD into the CD-ROM drive of your computer.
The CD autoruns and displays the initial screen, then the Main Menu
from which you can start the installation.

a Getting Started with Your Pocket PC - Microsoft Internet Explorer

ited with Your Pochet PC

MyPal A620

About This CD

rsus Microsoft

3. Click on Start Here from the Main Menu.

Microsoft® ActiveSync®

Download from Www.Somanuals.com. All Manuals Search And Download.
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10.

3-4

Read the Overview before
installing ActiveSync 3.7 to make
sure that you perform the
installation sequence correctly.

If you have not installed Outlook,
install it now. Click Install
Outlook 2002 and follow the
screen instructions to complete
the installation.

Click Download Connection
Wizard and read the overview to
see if you require the wizard.
Follow the screen instructions to
install the wizard on your
computer. Return to the Main
Menu when done.

Click Install ActiveSync 3.7,
then click Install.

Install Microsoft®

E6utiook

© mstall

When prompted, select Run this
program from its current

location then click OK.
Click “Open.”

Follow the succeeding screen e
. . . . . nstallation Complete
instructions. Click Finish to

complete the installation.

Restart Windows when prompted,
then proceed to the next section
to connect your device to your
computer and start
synchronization.

Setup has suceessfully installed allfles necessayto un
Microsoft ActiveGync and set up a connaction betiwssn your

mabile

Click Finigh to exit this wizard

< Back I Finish I Cance] Help:

Chapter 3
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Synchronizing your device

Connecting your device to a computer

To connect your device to your computer:

1. Place the device on the cradle.
2. Connect the AC adapter to the power connector on the cradle.

3. Connect the USB sync cable from the cradle to a USB port on your
computer.

To connect your device to
your computer without the
cradle:

1. Connect the traveling USB sync
cable with 26-pin connector to the
26-pin connector at the bottom of
the device.

2. Connect the other end of the cable

to a USB port on your computer.

26-pin connector

Microsoft® ActiveSync®
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Setting up a partnership

Immediately after you have completed the installation, the New
Partnership wizard will start automatically to help you establish a
partnership and customize your synchronization settings. At this point, you
can decide exactly which types of information you would like to

synchronize with your computer.

A partnership is a file that allows you to synchronize your device
with your desktop computer. This file is stored on your desktop
computer. An additional file that enables your desktop computer to
recognize your device is stored on your device.

To set up a partnership:

1. When the New Partnership
screen appears, select Standard
partnership for the type of
partnership to establsih between
your device and your computer.
Click Next.

2. On the next screen, select
Synchronize with the desktop
computer. Click Next.

3. Select the type of information that
you wish to synchronize. Click
Next.

OR

If you wish to customize a
synchronized item, highlight the
item then click Settings.

3-6

Download from Www.Somanuals.com.

Set Up a Partnership

This wizard helps pou establish a partnership betwesn pour
mobile device and this computer, You can et up either 5
standard partnership to synchronize data between your
device and this computer, or 3 guest partnership to simply
transfer data between your device and this computer.

‘what kind of partnership would you like to establish betwesn
your device and this computer?

Bianh Mext > Cancel Help

New Partnel 5‘

Specify how to synchionize data
Chaose to synchranize with your desktop and/or a server

“fou can synchronize data, such as e-mail messages and calendar items, between your

devl:e and this desklop computer However, if you have access ko a Microsoft Exchange
e Act S ne, you can alsa choose some inform I Iyp to

er, getting the mul ptdt information, even when you

How do pou want to synchronize with your device?

ichranize with this desktop computer

nchianize with Microsoft Exchange Server andfor this desktop computer
[Mate: Y'ou must hav e b M solt Exchange Server with Exchange ActiveSync
or Microsoft Mobile Inf Form tion S er ]
< Back Next > Cancel Help
New Partnership x|
Select Synchronization 5 ettings
Select the type of information you want to spnchionize:
To I’\ pt\yplfrmal \lthkatp
sync! S e
Mobile Device I Deesktop Computer l -

To find out mare about and to customize what gets sunchronized, click Setlings... I
on that infarmation tpe in the list and then click Settings.

<Back Next > Cancel | Help |
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On the Calendar |

Synchronization Settings s e
Wi ndOW’ for‘ exam ple ’ Se | eCt from device with Microsoft Outlook: an this computer

the options how you wish to i

synchronize the appointments on [2_=lferieeammn s

your device with your computer. CEE L

Cl I Ck O K . categories:

kK I Cancel Apply

4. Click Finish to complete setting a
partnership.

Setup Complete

eady to start exchanging information between
this compuiter

Upan exiting this wizar soft ActiveSyne will open and

|F pour device is a guest, click Explore on the toolbar and
start exploning your device.

If your devics has & partnership, synohionization statts
Please wait until synchronization is complete before using
your device.

Click Finish to exit this wizard,

Immediately after you set up a =l

File Wiew Tools Help
partnership, ActiveSync® starts ® © |2 &8
automatically and initiates the first S L Dot e e e

. . Pocket_PC
synchronization between your —_— G
devi Ce an d you r Com p ute r. 167 iterns nat spnchronized
. . (—

Refer to the succeeding sections T
for more details on B g
synchronization. e e

;ﬁ]lnbox Synchranized

Notes Synchronized

[#¥Files 24 items not synchronized

Microsoft® ActiveSync®
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Checking synchronized information

After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You will notice that the calendar information in
Microsoft Outlook on your computer was copied to your device, and the
information that you have on your device was copied to your computer.

3 Microsoft ActiveSync | o] [
File Miew Tools Hel|:u

@ QO

Syvnc Stop

Pocke t_PC Q
1+
Connected 5

Synchronized

Information Tvpe | Skatus

ECaIendar Synchronized
ECDntacts Synchronized
Tasks Synchronized
h Favorites Synchronized
@Inl:u:ux Synchronized
Nu:utes Synchronized
(=¥ Files Synchronized

NOTE Open Microsoft Outlook on your desktop computer to see the

details of copied information from your device.

3-8 Chapter 3
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Manually initiating synchronization

Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tapt=d, then tap ActiveSync to display the ActiveSync screen.

£F | activesync & 441051 €3

{9! .
Connected # | Connection status

Tap to connect and synchronize
Tap to stop synchronization

[
@ Sync 6 Stop

Synchronize with Windows PC
Synchronization finished

Tools E|*

Tap to synchronize via IR or
change synchronization settings

2. To start synchronization, make a connection between your device and
your computer, then tap Sync.

To end synchronization, tap Stop.

For more information on synchronization:

Tap B while in the ActiveSync screen, then tap Help.

Microsoft® ActiveSync®
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Synchronization options

The Microsoft ActiveSync program allows you to customize your
synchronization settings at any time. You can select the items to
synchronize, set the synchronization schedule, and specify the

synchronization rules.

To display the synchronization options:

To select items to synchronize:
1.

3-10

From the ActiveSync window on your desktop computer, click on the

Options icon, or

From the menu bar, click on Tools, then Options.

Check the box opposite the item
that you wish to synchronize.

Highlight a checked item then
click on Settings to specify
synchronization options for the
item.

For example, highlight Calendar
then click on Settings to display
the Calendar Synchronization

Settings window. Customize the
available settings, then click OK
when done.

Do the same for the other
checked items.

NOTE: You cannot set the
options for unchecked items.

Click OK when done.

options x|

Sync Options |Schedule| Fiules |

Desktop
To synchronize a type of information, select its check box
To stop sunchronization. clear the check box.

Mobile Device: Settings. I

=R Calendar
[ % Contacts
W Tasks

[ Favorites

1% Pocket Access
™I Inbio
W& Notes
154 Files |
¥ Sunchionize mobile device clock upon conhecting

Server

To enable. disable or modify spnchronization with a server,
cannect your device.

I~ Enabls synchionization with a server

Calendar Synchronization Settings x|

Calendar Synchronization

Synchronize the appointments in Calendar on your mobile
device with Microsolt Qutlock on this computer.

' Synchranize all appaintments.

™~ Synchionize only the

If + | past weeks of appointments and
Iﬂil | future weeks of appointments.

Spnchronize only thoze appointments in the follawing selected
categornes

Wl <No Categomys

QK I Cancel Apply

Chapter 3
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To set synchronization schedule:

1.
2.

To specify synchronization rules:

1.
2. Select your desired settings from

3.

Click on the Schedule tab.

Select your desired
synchronization schedule.

Click OK when done.

Click on the Rules tab.

the available options.
Click OK when done.

Microsoft® ActiveSync®

options |

Sync Optians - Schedule |Hules |

Deskiop schedule
'_ﬁe You can synchronize continuously [whenewver infarmation
“J changes], oh connection (onl) when you conhect the device to
the PC], or manually [when click the Spnc button].

When connected to my PC, syno: | ERiananen]

Server schedule

&E ‘You can synchionize with a server using the connection to your
PL

‘When connected ta my PC, syne: Every 5 min: hd

wireless schedule
@ Specity how often to spnchionize when using a wisless

connection,
Manually had
Manually -
Peak Times

[T Spnc outgoing items as they are sent.

During peak. times, sync;
Dwring off-peak. times. sunc:

When roaming. sync:

Cancel

Sync Dptlunsl Schedule  Rules |

Conflict Resolution

4=’-_~> IF there iz a conflict [an item has been changed on bath
‘ the mobile device and desktop computer or server]

Tl v the, term un

Server Always replace the item on my device j

File Conversion

W 3 Set how files will be conwerted when they are copied, moved,
tD or synchronized between this computer and your mobile

device.
Corrersion Seftings

Pazz Through

‘- Ta use pass through, this computer must be conhected.

ol i
Connection: IThe Intermet ﬂ

¥ Open ActiveSync when my mobile device connects

Cance|
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Introduction

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
e-mail address stored in Contacts can be used to address e-malil
messages in Inbox.

Using ActiveSync®, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes you
mode on your device and desktop computer or server and updates both
computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping B,

Calendar: Scheduling appointments
and meetings

Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views using the
View menu.

l.‘;!:gf Calendar & £ 004 9
Jun 03,03 sMJw TFs §i=%1— Taptogo to Today

Lunch meeting w, Macy & Cyndrel . .
12:00p-2:00p ——— Tap to display or edit the

appointment details

Conference call
4:00p-5:30p

Mew Tools E"J E @ E|‘

Tap to create a new appointment

NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the Tools
menu.

4-2 Chapter 4
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Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the

appointment,
2. Tap New.

L.f:@' Calendar

& 42 905 (D

Appoinkment

Subject:
Location:
Starks:
Ends:

All Day:
Qcours:

Reminder:

Cateqaries;

-

L=

— Tap to select from a predefined text
— Tap to select from previously
entered locations

— Tap to specify the time of appointment

5,/3/03 12:00 P i
£/303  1:00PM ™
Moo |

Once

Remind me

15 minubeds)

Mo cateqories...

Tap to specify the date of appointment

Motes |

Tap to add notes to the appointment

123(1]2]3

4[s[a]7[8][o]o]-]=]«

Tabjg|wle|r[t]y[uli[o]p

—
—

caPlals[d][f]aln]ilk]1];]"

shiftfz[z[c[v][b[nm][, [.[/]+
culai]* [y ] [4]t]e]=
Edit |~

3. Using the input panel, enter a description and a location. Tap to select

the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to
see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the “Notes:

Capturing thoughts and ideas” later in this chapter.
7. When done, tap OK to return to Calendar.

NOTE

If you select Remind me in an appointment, your device will

remind you according to the options set in EE, Settings,
Personal tab, Sounds and Notifications.

Microsoft® Pocket Outlook
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Using the summary screen

When you tap an appointment in Calendar, a summary screen appears. To
change the appointment, tap Edit.

& {2913 (D
Conference call A
4/00p-6:30p Tue, 5/3/2003 ~ —— [ Appointment details
Audio-visual Room 10
AGENDA — Notes/additional information
1. Product documentation SOPFlawchart on the appointment
2. Cost analysis
3, Schedules
Edit Tools E|A
|

Tap to change details of the appointment

Creating meeting requests

You can use Calendar to set up meetings with users of Outlook and
Pocket Outlook. The meeting request will be created automatically and
sent either when you synchronize Inbox or when you connect to your
e-mail server.

To create a meeting request:
1. Tap Tools then Options to indicate how you want meeting requests
sent.

2. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting:

1. Create an appointment.
2. In the appointment details, hide the input panel, then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and place in the Outbox
folder. For more information on sending and receiving meeting
requests, see Calendar Help and Inbox Help on the device.

4-4 Chapter 4
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Contacts: Tracking friends and

colleagues

Contacts maintains a list of your friends and colleagues so that you can
easily find the information you look for, whether you are at home or on the
road. Using the infrared port (IR) on the device, you can quickly share
Contacts information with other device users.

Tap to select the category of
contacts you want to display

L.g:f Contacts

#ab|cde] foh| ik [Imn{opa] rst juew] sz
Banas, Arnel  552-6798 W[
Bayani, Beth 526-9597to 98 loc. w [ |
Canzon, Fe b633-8277

Chavez, Beth 2754-3583
Chong, Frey D917-8334865
Cruz, Mila 0919-2235574

De Lara, Myla 8691-1771
Evangelis
Floresta, K

Garcia, Dg
Garcia, De Beam Contacts

Copy Contacks
Delete Contacts

Garcia, Dijy Options...

Garcia, Le
Gonzales,| Send via Bluetooth

S TT|S3fEETEZIIEE

Pl

Huang, An Dial ¥ia Bluetooth
Nelw 'lll'iFw Tools

B
G

All Contacts +  [Find aname —— Tap and enter part of a name

to quickly find it on the list

Tap to display or edit the contact details

Tap to display additional phone
numbers and email addresses

Tap an action for a selected contact

Tap to sort contacts by name or company

Tap to create a new contact

NOTE To change the way information is displayed in the list, tap

Tools then Options.

Microsoft® Pocket Outlook
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Creating contacts

To create a contact:

1. Tap B, then tap Contacts. £ig|contacts & g1 @
2. Tap New to display a blank o e
contact form. Department; i
3. Using the input panel, enter a o
name and other contact ok Fax:
information. You will need ot scroll Wﬂrkaddf|= ik
. . E-rnail: | |
down to see all available fields. o =
4. To assign the contact a category, Detal | ot |
: 123[1[2[3]4[s5]6[7[8[o]0]- [
scroll to and tap Categories, then Tab||q||w||e ||r ||t ||v ||u||i ||u||p I[ I]
: caPla|s|d|f|alh|jlk|1];]"
select a category from the list. On it 2]% [€]v [bIn[m], [ [/]+
the contact list, you can display ctfan]* [\ | s[r]e]>
the contacts by category. i Ela

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

6. Tap OK to return to the contact list when done.

Using the summary screen

Tapping a contact on the contact list displays a summary screen. To
change the contact information, tap Edit.

i o 1€ 11z
£iF |contacts & g 11:43 (D

John Mark 1. Casifio
General Manager
Prosper Enterprises

— [  Contact details

321 Diliman St ‘hork addr
San Rafael, RP

iohnmark@prosper.com E-rnail

Summary | Mokes I Tap to display notes
Edit Tools z|a-
L

Tap to change contact information
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Finding a contact

There are four ways to find a contact.

1. On the contact list, enter a contact
name in the box under the
navigation bar. To show all contacts
again, clear text from the box or tap
the button to the right of the box.

2. Inthe contact list, tap the category
list (labeled All Contacts by
default) and select the type of
contact that you wish to display. To
show all contacts again, select All
Contacts. To view a contact not
assigned to a category, select
None.

3. To view the names fo companies
your contacts work for, in the
contact list, tap View > By
Company. The number of contacts
that work for that company will be
displayed to the right of the
company name.

4. Tap =, Find, enter the contact
name, select Contacts for the type,
and tap Go.

Microsoft® Pocket Outlook

¥ Contacts £, < 10:55
L) X

11

AL

v All Contacts harientos@exc... & |a

Mo Categori -2911141 h -

m =

ASUS

iy 6—42223103 w —
Philippines 0080 -
Taiwan 1) 757-4844 h
us m
More... i
oy AT w
Bercilla, Siony m
Canzon, Fe 633-8277 w
Carlson, Kat... 919-55712386 h
Casifio, Cynt... 0919-7329914 m

Chang, Kelvin 2311-3267 h | |

Chavez, Arm... b644-8451 h |~

New Yiew Tools £|4

£33 |contacts A 4 10:58 €9
All Contacts ~ |Find a name |
#ab|cde] foh] ik [Imn{opal rst Juww] sz
Abarientos, ... mabarientos@exc... e

Aberin, Lorna 718-2911141
Alba, Susan 0919-4590617
Ang, Eugene 400-4222 x103
Ang, Precious 813-0080
Atienza, Leo 2826-2b5b
Balis, Christian {093) 578-5749
Baiias, Arnel  552-6798
Bayani, Beth 526-9597 to 98 loc.
Bercilla, Siony 0926-170374
Canzon, Fe 633-8277
Carlson, Kat... 919-5571286

Casifg [ 1919-73729914
'n & * By Name
Chay By Company 3

Mew ¥iew| Tools

[ _J»

fo|TT37E3EE3 TEETT

Find:  beth 0 - [}3
Type: Contacts - | Go

Results
El Bayani, Beth
Contact 526-9597 to 98 loc.
E] Chavez, Beth
Contackt 2T54-3583
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Tap to select the category of
tasks you want to display

& 2802 €3

Tasks: Keeping ato do list

Use Tasks to keep track of what you have to do.

all Tasks ~

Priority « -

| ' | 1 || Tap here to add a new task

—— Tap to select a sort
order of the task list

[]* Fileincome tax

[] Arrange documents/pictures
Buy gift for Chloe

Indicates high priority

Meet w,/ Brian

__________________

[
[] call Edwin
[]

Create Copy

Tap to display or edit
the task details

L Tap and hold to display a
pop-up menu of actions

Delete Task

Beam Task...

Tap an action for the task

Mew Tools
1

2|

Tap to create a new task

Creating tasks

To create a task:

4-8

Tap & | then tap Tasks.

Tap New to display a blank task

form.

Using the input panel, enter a

description.

Enter a start date and due date,

or enter other information by

tapping the field first. If the input

panel is open, you will need to

hide it to see all available fields.

Download from Www.Somanuals.com. All Manuals Search And Download.

Subject:
Friority: Mormal
status: Mot Completed
Skarks: i\ane
Due: Mone
Occurs: ONCe
Reminder: [None
Cakeqories: MO Cateqories...
Task| Notes‘
123[1]2[3[4]5]6]7]8]0]0]- =]
Tablg[wle[r|t[y[uli|o[p[[]]
CaPlafs[d[fla[h[i[k[1]:]"]
shift/ z[x [c[v[b[n[m],[.[/]+
ctlai] " [\ ] NEEE
Edit @H
Chapter 4



. To assign the task to a category, tap Categories and select a category
from the list. On the task list, you can display tasks by category.

. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

. Tap OK to return to the task list when done.

TIP

To quickly create a task with
only a subject, tap Entry Bar on
the Tools menu. Tap Tap here
to add a new task and enter
your task information.

Using the summary screen

& 42103

Process invoices for payment i

Starts: 622003
Due: 6,/3/2003

bed

Advise accounting dept. of new depository
banl:

Edit Tools E|A
]

Tap to change the task details

Microsoft® Pocket Outlook

Completed - Priority -

| ' | 1@ Tap here to add a new task

Mew Tools

Vi

—— — Task details

+— Tap to show or hide the task details

Download from Www.Somanuals.com. All Manuals Search And Download.
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Notes: Capturing thoughts and
iIdeas

Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will
be included in the note as an icon. If the note is displayed, it will be
created as a stand-alone recording.

& 421222 €3

i=; All Folders - Name -—— Tap to change the sort order of the list
[_|Birthday greeting... 5/29,/03 62k
[_]china printing 12:15a 3k+—— Tap to open a note or play a recording
Drawing 5/29/03 884b
B ek it 12:15 8 1k Tap and hold to display a
Create Copy .
- 5/29/03 1k pop-up menu of actions
12:15a 1k . .
select all S I20]0F—00AD Tap an action for the item
Send via E-mail... 12:12 a 556b
Beam File... 12:12a 520b
12:12 a 584h
l_.RenamefMuve... 12:12 a 672b
Quute 5 1212a  628b Tap to record
@ |m|) |[[—— ||m|ut
Nllaw Tools & |A

Tap to show or hide the recording toolbar

Tap to create a new note or recording

You may change the default Notes options including the writing mode,
template, file storage, and record button action.

To change the Notes options:

1. Tap k=, then tap Notes. £ & d¢ 1248 D

Tap Tools, then Options... to
display the options screen.

3. Make your desired changes. Default temnplate:

4. Click OK [Flark Nate -]
| . Save to;
|Mair'| TMEMOory v|

Record button action:
|Swit|:h to Motes v|

Global Input Options

4-10 Chapter 4
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Creating notes

To create a note:

1. Tap &, then tap Notes.
Tap New to display a blank note.

3. Create your note by writing, drawing, typing, or recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

Tap to save the note and
return to the Notes list

1. Prepare hi-res POF (2400 dpi)
*POF contents must be proofread
thoroughly before creating a CD
*cover: either Photoshop source file
or hi-res POF (A3 size)
* when sending Photoshop source
file, gend also low-res JPG for
procfing

2, Copy PDFs to CO
3. Send fo China by Fedex, DHL
4. Checking in China:
a. Print out POF to check contents
b, Use POF or JPG file o check
Cover —|
¥ mav consider hiringfassioning 3

New Edit Tools (21 2 ZJ= Tap to show or hide
| the input panel

Tap to write on the screen

Tap to add a recording to the note

Microsoft® Pocket Outlook 4-11
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Inbox: Sending and receiving e-malil
messages

Use Inbox to send and receive e-mail messages in one of these ways:

» Synchronize e-mail messages with Microsoft Exchange of or Microsoft
Outlook on your desktop computer

« Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages

E-mail messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization in
ActiveSync. For more information on enabling Inbox synchronization, see
ActiveSync Help on your desktop computer.

During synchronization:

» Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your device.
By default, you will receive messages from the past three days only, the
first 100 lines of each message, and file attachments of less than 100KB
in size.

» E-mail messages in the Outbox folder on your device are transferred to
Exchange or Outlook, then send from those programs.

» E-mail messages in subfolder must be selected in ActiveSync on your
desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop
computer from a remote location. For more information, see
Chapter 7.

4-12 Chapter 4
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Connecting directly to an e-mail server

In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail
server using a modem or network card connected to your device. You
need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see Chapter 7.

When you connect to the e-mail server, new messages are downloaded to
the device Inbox folder, messages in the device Outbox folders are sent,
and messages that have been deleted on the e-mail server are removed
from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a
message on your device, it is also deleted from the e-mail server the next
time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded new message headers
or partial messages, you can disconnect from the e-mail server and decide
which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.

Microsoft® Pocket Outlook 4-13
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Using the message list

The messages you receive are displayed in the message list. By default,
the most recently received messages are displayed first in the list.

Tap to select the service, and the
folder that you wish to display

Inbox + Received Date v —— Tap to select the sort order
& cyndrell@syner.. 1:46 PM 1K for the messages
Board meeting
New Tap and hold to display a
Delate pop-up menu of actions
Al Move
) jol il 1K
L Repl
glg oPY 1 1K
gri Reply all
(& lar  Forward n 1K
Pu|
By My Send/Receive il 1K
RE  Mark as Read
Mark for Download

Inbox; ActiveSwnc 7 Items,

MNew Tools Accounts Ji._l % E|A
1 [l

Tap to connect, and to send/receive e-malil

Tap to connect to the selected service

When you receive a message, tap it to open. Unread messages are
displayed boldface.

A S T L ol Tap to return to the message list

From: Macy Casifio
Subject: Board meeting
Sent: 62003 905 AM

4

dear Cyndrell,

Please send out meeting notices today ko all
board members, Attach agenda for June 30
semi-annual board meeting.

Thanks,
Macy
Tap to delete this message
| Tap to reply to or forward this message
Edit =% =t @ o £|A
Tap to view the next message
Tap to view the previous message
4-14 Chapter 4
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When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new messages, and file attachments of less
than 100KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message that you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You can specify your downloading preferences when you set up the
service or select your synchronization options. You can change them at
any time.

« Change options for Inbox synchronization using ActiveSync options. For
more information, see ActiveSync Help on your desktop computer.

« Change options for direct e-mail server connections in Inbox on your
device. Tap Tools then Options. On the Service tab, tap the service that
you wish to change. Tap and hold the service and select Delete to
remove a service.

Microsoft® Pocket Outlook 4-15

Download from Www.Somanuals.com. All Manuals Search And Download.



Composing messages

To compose a message:

1. Tap New.

2. Inthe To field, enter an e-mail or SMS address of one or more
recipients, separating them with a semicolon, or select a name from
the Contacts list by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts appear in the
Address Book.

Tap to send the message

¢ 100 (G

Send|subj <. =

4

+—— Tap to show or hide the
complete message header

ABC ! abc ! 123 4
_________________ Ll e
PR
. . HE
Edit My Text -
it My | ex IEI |_|_|

|
| Tap to show or hide the recording toolbar

Tap to display the e-mail address book
Tap to select a preset message

3. Compose your message. To enter £ 22 @
preset or frequently used B 1o roeorosper o
messages’ tap My Text and Send |Subj: New business ¥
select a message. e

4, Tap Send when you have finished Please prepare all supporting documents to the
the message If you are Working financial stakement For bomorrow's board

. . meeking.
offline, the message is moved to
the Outbox folder and will be sent s
the next time you connect. John Mark
Edit My Text [=] [= 4
4-16 Chapter 4
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Managing e-mail messages and folders

The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

 If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will
automatically be sunchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for
synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read messages while
away from your desktop computer.

« Ifyou use SMS, messages are stored in the Inbox folder.

 If you use POP3 and you move e-mail messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. This prevents you from having duplicate copies of a
message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
device.

 If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.

Microsoft® Pocket Outlook 4-17
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The companion programs consist of Microsoft® Pocket Word, Microsoft®
Pocket Excel, MSN Messenger, Windows Media™ Player for Pocket PC,
and Microsoft® Reader.

To switch to a companion program on your device, tap Programs on the
menu, then tap the program that you wish to open.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give
you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your desktop
computer to your device. Synchronize documents between your desktop
computer and your device so that you have the most up-to-date content in
both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
or trip reports.
Creating Pocket Word documents

To create a new Word document:

1. Tap =i tap Programs, tap

l.ir?"j’ Programs 1-'-';‘ s 2:30 &4
Pocket Word to launch the B @ B
application.
Lo . ASUS Games Calculator
If you have existing Microsoft Progiane ;
Word or Pocket Word documents %f) N
in your device, a list of the HleSglores ifoge: Pt
documents appears. B
pp < ‘?
ocket Excel Pocket MSN

Pictures Terminal
Services

4]

Vas

NOTE If you selected a template for new documents in the Options
dialog box, that template appears with the appropriate text
and formatting already provided.
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2. Tap New to display a blank document.
3. Use any of the tools in the input panel to type your text.

£F [pocket word & {2 213 (O Tap to save and close your document
| ———+—— Type your text here

F B I U|[E]= =|i= 1 Formatting toolbar
12301[2[3[a[5]e][7][8]0]0]-[=]e«

Tabla|wle|r|t|y|uifo[p[[]]

caPlafs[d[f]g[h[i[k[I];]"]

shift[ 2 [x [c[v[b[n[m[,|.[/]+

culaia] = [\] [4]t]e]>

Pt Edib wiEes ot =] — Tap to select an input method

Tap to show or hide the input panel

Tap to show or hide the formatting toolbar

Saving Pocket Word documents

To save a Pocket Word document:

When you have finished editing your document, tap OK.

The document is saved using the first line as file name if you did not
specify a file name. For example, if your first line in the document has
the words Bits-n-Pieces, these words appear in your Word documents
list.

L.‘;Fgf Pocket Word ot g 2145 9

l&rr'rj' Pocket Word g 2244 @

== Personal - Name |

[\ Bits-n-Pieces z43a 16k

Bits-n-Pieces

On Success

Most pecple search high and wide for
the keys to success, If they only khew,
the key to their dreams lies within,

- George Washington Carver (c. 1864 -
13437, Botanist and scientist

O friends s Friendsiips

Friendship consists in forgetting what
one gives and rermembering what one
receies,

- Saint Ailved of Rivauls (1109 - 1166),
Histotian and abbot

On Courage

Courage is the finest of human qualities
hecause it guarantees all the others,

- Sir Winston Churchill (1874 - 1985],
Eritish Prime Minister

[ [ w

4]

Mew Edit Yiew Tools T E|A New Tools E|A
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To specify save options:

1.

5-4

With the document open, tap

Tools f@' Pocket Word +F oz 3:30
5 A
From the pop-up menu, tap Save Bl
Document As... to display the hame: | STETEEGE |
Save As screen. Folder:  [Persanal ~|
Change the file name by simply Type:  [Pocket word Docurent (* -
typing a new one in the Name Location:  [Main memary -]
fleld' ‘ DK | | Cancel |
Tap the down arrow in the Folder 123|1|2|3|4|5|E-|?|B|_9|I]|- P
field to select a folder where you Tablg[wle[r[t]y[ulifo[p[L]]
- , caPla[s[d[fla[n[i[k[I]:]"]
wish to place the file. shitt| z[x[c[v[b]n[m], [.[/]«
ctfaa] " [\] [4[t][<]>
=R

Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:
« Word (.doc)

» Pocket Word (.psw)

* Rich Text Format (.rtf)

» Plain Text (.txt)

Tap the down arrow in the Location field to indicate the location of

your saved file, either in the main memory of your device, or in a
storage card, if available.

Tap OK when done.

NOTE If you do not wish to change the document format, but would
like to change the file name, folder, and location of your
document, simply tap Edit from the command bar, then tap
Rename/Move... from the pop-up menu to make your
changes.

Chapter 5
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Opening an existing Pocket Word document

Pocket Word contains a list of the files stored on your device. Tap afile in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Tap to select the folder you want to display

l&rﬁ’ Pocket Woid +F oz 2:30 9

i=all Folders

MName

—— Tap to change the sort order of the list

+—— Tap to open a document

® |BA bank info 2:21a 2k
& Bits-n-Pieces 2:21a 16k
cnmmentatnr gui... 2221 a 17k
&' DailySurvivalKit 2:21a 29k
LEM'U'ING LAS ¥EG... 221 a 10k
press release 221 a Sk
& sARS 2:21a 17k
5unriseinNew"|"nrk 2:21a L06k
New Tools E|A

Tap to change document settings

Tap to create a new document

NOTE You can open only one Pocket Word document at a time;
when you open a second document, you will be asked to

save the first.

Companion programs
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Modes of entering information

You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, or recording), which are displayed on the View menu.
Each mode has its own toolbar that you can show or hide by tapping the
Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.

To change the zoom magnification:

1. Tap View, then tap Zoom.
2. Select your desired percentage.

Select a higher percentage to enter text and lower one to see more of
your document.

Typing Mode
Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit and Find/Replace.

l.‘;!:gf Pocket Word &t o€ 345 @

l.‘;!:gf Pocket Word &t g 348

SEVERE ACUTE QSR |- Firid
SYNDROME E
| Redd is nat mild,
cut rauge it is [ Match case
Copy very [ ] Match whale words anly
- :;:!SE'E mptoms of
edar ferwy o =
celect Al K OIS | | Replace... | | Find I | Cancel |
= o it roainle [T
123 Format... 90]-|= 13[1[2[3[4[5]6[7[8[9[0][-[=[«
Tah]| Paragraph... i[o[p[[]] Tablg[wle|r[t]y|uli]o][p[L[]]
CAP| Find/Replace... ANRE caPla[s[d[f]a[h][i[k][1]:]"]
Shifl ARFEE shift] 2 [2 [c[¥[b[n]m],.]. /] +
cti]{ Rename/Move.. [4]1]<]= ctfaia] " [y ] [V]t]e]=
MNew (Edit|¥iew Tools 1, B |~ B |~
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Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

.‘fwj’ Pocket Word +3 42 1:06 @

_EXCULLEME

{ In ﬂ = Write your text here
.
Py [
MAST '
J L With the Space button selected,
drag to insert space. An arrow

appears showing the space
direction direction and size.

= Space button

[
A e T e

Ew Edit Yiew Tools E|*
I
Tap to show or hide the writing/formatting toolbar

=

Pen button

#¥|pocket Wor o WE 4
£3 [pocket word &t ¢ 408 (D

EXCELLEVEE | &
mapsT !

ook

v Wrap to Window Tap to wrap text to screen

= Writing
Drawing
Typing
Recording

E |‘ Zoom P i
MNew Edit ‘fil?W‘TﬂDlS E|A
| Tap to display the menu

4]

Tap to display zoom percentages

NOTE If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and
manipulated as described in the next section.

Written words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document on
your desktop computer.
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Download from Www.Somanuals.com. All Manuals Search And Download.



Drawing mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after ther first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

l.fw? Pocket Word o £ 4:509 @

Resize an object by dragging

rj the selection handles

: . i ’ Tap to select the formatting options
2|8~ L] Bl o a5 -+ [ T4 — Drawing toolbar
MNew Edit| Yiew Tools E|‘
|

Tap to show or hide the drawing toolbar
Tap an arrow to display the options
Pen button

Recording mode

In recording mode, embed a
recording into your document. £F|Pocket word & dgans D
Recordings are saved as .wav files. @

For more information on recording,
see Chapter 2.

Important
Announcement

Embedded recording

19 June 2003

New Edit Yiew Tools T E|A
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give
you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your desktop
computer to your device. Synchronize workbooks between your desktop
computer and your device so that you have the most up-to-date contents
in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View, then tap
Toolbar.

L.g:f Pocket Excel o oz 215 @

&3 12191958
A | B |
1 | $£19,621,110.00

2 | £19,700,327.00

3 | £12,191,958.00 |
4
5
B

— Cell contents appear here as you
type, or when you select the cell

|
[T

Format button
A ] : I —— AutoSum button
Refdy  [Sheetl w ||Sum=$12,191,9 -
| E = =|z|$ : .0 & -—1— Zoombutton
123(1]2[3]a]s]a]7]8]9]0]-[=]«
Tab[q[wle[r[t|y[uli[o[p[l

capla[s[d[f[a[n]i[k[1]:]"
shift[z [ [c[v[b[n[m], . |
ctulai]* [y ] 1
MNew Edit Yiew Format Tools | T, |~

—

NOTE You can open only one Pocket Excel document at a time;
when you open a second document, you will be asked to
save the first.
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Creating Pocket Excel documents

To create a new Excel document:

1. Tap =i, tap Programs, tap

Pocket Excel.

Tap New to display a blank

document.

If you selected a template for new
documents in the Options dialog

box, that template appears with

the appropriate text and
formatting already provided.

l.f;? Programs ooz 230 £

I

Programs

File Explorer Microsoft

Services

ASUS Games Calculator

Messenger |=

W

Pocket \ Pocket Excel Pocket MSN
Word

2
Pictures Terminal

[

3

MSMN

Saving Pocket Excel documents

To save an Excel document:

When you have finished editing your document, tap OK.

5-10

By default, your document is saved as Book1 as file name. You can
change the file name to one that is more descriptive of your document.

See next section for saving options.

fr'}' Pocket Excel Pl FAFTLCY | @

-
o

A | B | ®©

Date | Account Sales

11-0ct Macy £ 1,956.00
22-Feb Cyndrell £ 1,938.00
27-May John Mark £ 1,995.00
2B-Mar Gleanne £ 1,998.00
31-0ct Lanz £ 2,001.00
2-Jul  Chine £ 2,002,00

00 = [ |ln | (D2 I [

]

10

[T S

-

L m ] v 1] |

Ready |Sheetl w |[Sum=0 -

F EE[=|=z|s s o|q

Mew Edit Yiew Format Tools E|A

fr'}' Pocket Excel + oz 216 9

E]A.II Folders - Mame |

5 1Book1 415a 442b

New Tools E|A
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To specify save options:

1.

With the document open, tap
Tools.

From the pop-up menu, tap Save
Workbook As... to display the
Save As screen.

Change the file name by simply
typing a new one in the Name
field.

Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

.'%F Pocket Excel

Save As

Mame:  [Gross sales |
Folder:  [MNane -
Type:  |Pocket Excel Workbook (* +|
Location:  [Main memory -
| ok || cancel
iz31]2[3[a[5]6[7][8]9]0]-[=[«

Tabjg|wle[r |t]y|u[i|o[p|[]]

Caplafsfalffalh]ifk[1]:]"]

shiftfz[x[c[v[b]n]m], [.[/]+
ctlai] - [ ] L[t]e]>
e

Tap the down arrow in the Type field to select a file format.
You can save the document you create or edit in a variety of formats:

» Pocket Excel (.pxl)
» Excel (xIs)

Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a

storage card, if available.
Tap OK when done.

NOTE

If you do not wish to save your workbook to a different format,

but would like to change the file name, folder, and location of
your document, simply tap Edit from the command bar, then
tap Rename/Move... from the pop-up menu to make your

changes.

Companion programs
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Securing your Excel document

If your workbook contains sensitive or confidental information, you can
protect it with a password.

To set a password for your workbook:

1. Open the workbook.

S Pocket Excel Fndl 3 H
£ |Pocket Excel ot oz 50 (D

2. Tap Edit from the command bar, P—

then tap Password ... to dlSplay Sek or change password For 'Gross .5

the password setting screen. Password: [nes |
3. Type a password in the Verfy password: [rxets |

Password field.

4. Re-type the password in the
Verify Password field.

1231[2[3[4][5]e][7][8]0]0]- =]«
5. Tap OK when done. T S AN A A LR
caPlas[d[fa[h]j[k[1[:]"]
st z[z[c[v[b]n]m].[.[/]#
cufaa[ [\ ] L t]<]=
=S
If you have set a password for your £iF|Pocket Excel
workbook, a password screen Password
appears aSking you fo type your apecify the passwaord for 'Gross sales's
password whenever you try to open [ |
the workbook. ok | [ cancel |

Type your password, then tap OK. If
you type in a wrong password, a
message appears telling you so.

1z3l1]2[3]4]|s][6]7][8]0]o]-[=]«
Tabjg[wle[r[t|y[ulifo[p[[[]
caPla[s[d[f[a[n][i[k[1[;]"
shift[ z[x[c[v[b[n[m], . ]
cufain] - [ ] [4]0

|
!

{—l—;

B

NOTE DO NOT forget your password! You can not open your
workbook unless you type in the correct password.
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Tips for working in Pocket Excel

Take note of the following when working in large worksheets in Pocket
Excel:

« View in full-screen mode to see as much of your worksheet as
possible. Tap View, then tap Full Screen. To exit full-screen mode, tap
Restore.

« Show and hide window elements. Tap View, then tap the elements to
show or hide.

» Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View, then tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

« Split panes to view different areas of a large worksheet. Tap View, then
tap Split. Drag the split bar to where you want it. To remove the split, tap
View, then tap Remove Split.

« Show and hide rows and columns. To hide a row or column, select a
cell in the row or column that you want to hide. Tap Format, then tap
Row or Column, and tap Hide. To show a hidden row or column, tap
Tools, then tap Go To, and type a reference that is in the hidden row or
column. Tap Format, then tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap & , then tap Help.

Companion programs 5-13
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MSN Messenger

MSN Messenger on your device is an instant messaging program that
allows you to:

« See whois online
« Send and receive instant messages
* Have instant message conversations with groups of contacts

To use MSN Messenger:

You must have a Microsoft Passport™ account or a Microsoft
Exchange e-mail account.

You must have a Passport to use the MSN Messenger Service. If you
have a Hotmail® or MSN account, you already have a passport. Once you
have obtained either a Microsoft Passport or Microsoft Exchange account,
you are ready to set up your account.

Sign up for a Microsoft Passport account at http://www.passport.com.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To launch MSN Messenger:

1. Tap i, then tap Programs. 3§ |Programs
2. Tap MSN Messenger. = & =

AsSUS Games Calculator
Programs

File Explorer Microsoft
Reader

Pocket  Pocket Excel Pocket MSN
Word
o}
Pictures Terminal —
Services i
£+
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Signing up
To sign in to MSN Mesenger service:
1. Tap Tools then tap Sign in... from

the menu.
OR

."Z‘? MSN Messenger o L B:11 9

Simply tap the Tap here to sign "’
in area. Tap here to signin —

msn*"

Messenger Service

Tools Chats E|A
2. Inthe sign-in screen, enter your FF|MsN Messenger & € 612
e-mail address and password. Sign in name;
Tap S|gn In. [benerosa10@hotrall, com |

Examples:  name_123@hotmail.com
Ty name@msn, cam
example@passport.com

Password:

[ ] save password

|Eancel || Sign in I
123(1]2[3]4]s]6][7]8]9][0]-[=]«
Tabjq[wle|r[t[y[ufifo[p[L[]]
caPlals[d][f]aln]i[k[1];]"]

shiftfz [ [c[v[b[n]m]. ]. T/
culai]” [\] [4[t]e]>
=
NOTE If you already use MSN Messenger on your desktop
computer, your contacts will show up on your device without
being added again.
Companion programs 5-15
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Working with contacts

The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

.f:.? MSN Messenger ot 612

11 Kim Akers (Online)

;_L Online

‘i Adarn Barr

Ji Jo

g‘& Fandall {&way)
‘i Mot Online

‘i Richard Eready
‘i David Hodgson
_ @ S

——+—Tap a contact to gant a chat.

Send Mail {Tim@woodgrovebank.c...
Block ————Tap and hold to display
Delete Contact a pop-Up menu of actiohs.
Properties

Tools (Hats E|‘.

To see others online without being seen, tap My Status in the Tools menu
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap
Unblock on the pop-up menu.
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Chatting with contacts

Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, then tap Send. To invite another contact to a multi-user chat, tap
Invite in the Tools menu, then tap the contact that you want to invite.

.{1}‘ MSN Messenger o o< 6:12

| Enter message.

N T
Hi. Can you meet at 2:007 Sendi— T ap to send message.

1231 [2[3]4]s[6]7[g[0][0]-[=[«
Tabla[wle[r[t]y[uli[o[p[[]]
cAP[a[s[d[f[a[h][i[k[1];]"

shift|z[x[c[v[b[n[m[,[. ]/
cufain] - [\ ] [4]1]

Tools Chats My Text _'i = |~

—

¢—|—>

NOTE To switch back to the main window without closing a chat, tap
the Contacts button. To go back to your chat window, tap
Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the
message under the text entry area. For more information on using MSN

Messenger, tap ] , then tap Help.

l.}_f*."rf MSN Messenger &t o 61z

m Akers says ——Wiew full chat.
Hi. Can you meek ak 2:007

f.&.dam is typing a message. ———Wiew status of the chat.
123]1[2[3]4[5]6[7][8]a]0]-[=[«
Tabjg[wle|r[t]y[u|i[o[p[[]]
caPla[s[d[fla[h[i[k[I[;]"
shitt| z[x[c[v[b[n[m[, [.[/][ <
ctjaal” [\ ] [4[1]e]=

Tools Chats My Text _'i = |~

—
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Windows Media Player for Pocket PC

Use Microsoft® Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to

Windows Media Player for Pocket PC, tap & , tap Programs, then tap

Windows Media.

220 €3

l&rﬁ' Windows Media

@ ‘Media - 64 kbps

Ready - Tap Play

(> @O

Yelcame Ta W | [

Windows

Media Player

Bl -— Indicates the progress
of the current track

«) «=%_+—— Slide to adjust volume

Playlist Tools

Tap to stop

Tap to play or pause

Tap to mute sound

Tap to play the next track
Tap to play the previous track

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap

, then tap Help.
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Microsoft Reader

Use Microsoft Reader to read eBooks on your device. Download books to
your desktop computer from your favorite eBook web site. Then, use
ActiveSync to copy the book files to your activated device. The books
appear in the Reader Library.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:

« Page through the book using the Up/Down control on your device, or by
tapping the page number on each page.

« Annotate the book with highlighting, bookmarks, notes, and drawings.

« Search for text and look up definitions for words.

The Guidebook contains all the information that you need to use the
software. To open the Guidebook, tap Help on the Reader command bar.
Or, on a book page, tap and hold on the book title, then tap Help on the
pop-up menu.

To launch Microsoft Reader:

1. Tap &, then tap Programs. £ |programs
2. Tap Microsoft Reader. B @ 4]
ASUS Games Calculator
Programs
Egb uis JQ;%
File Explorery Microsoft MSMN
Reader Messenger |=
i W
Pocket  Pocket Excel Pocket MSN
Word
o]
Pictures Terminal .
Seryices =
2|~
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Getting books on your device

You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary ar also included in the MSReader folder in
the Extras folder on the Pocker PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your
activated device as described in the Read Me file in the MSReader folder.

Using the Library

The Library is your Reader home page. It displays a list of all books stored
on your device or storage card.

To open the library:

1. Onthe Reader command bar, tap Library.

On a book page, tap the book title, then tap Library on the pop-up
menu.

To open a book, tap its title on the Library list.

| v The Call of the Wild

- ‘CVT_ ——— Tap to scroll through
§ﬁaﬁi§§§m were booming the find, thousands the Library list
ogfion. | of men ﬁ Tushing mto e | |
Tap to select Northland. ThY Add Bookmark | — Dregto seecttextand
asort order —1 dogs, and e | g tendap an ot
Were heavy
Tap to search books — muscles by whig : _
by author o title coats to prota A4 Draning —— Allist of books you
frost Find... have stored appears
Buck lved Copy Text here
the sun-kissed Sama e Vel
Judge Miler's place, it was called.
It stood back from the road, haff
hidden among the trees, through
. which glimpses could be caught
Tap to navigate to of the wide cool veranda that ran
other parts of the
i5) | Tap attveto tum
Reader the page, o tap and
hield page # tabring
up page fffle.
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Reading a book

Each book consists of a cover page, and optional table of contents, and
the pages of the book. Navigation options are listed in the bottom portion

of the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open a book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and the

book title.

|« The Call of the Wild

—
Tap to select . .
aﬁavigatign were booming the find, thousands

aption. of men rushing into_the |

Morthland. Th
dogs, and the
were heavy
muscles by whig
coats to prote
frost.

Buck lived

Add Bookmark
Add Highlight
Add Note
Add Drawing
Find...

Copy Text

which glimpses

4

the sun-kissed Sama cara vaney.
Judge Miller's place, it was called.
It stood back from the road, half
hidden among the trees, through

could be caught

of the wide cool veranda that ran

L

Drag to select text and
thentap an option.

Tap armwstoturn
the page, ar tap and
hald page ¥ ta bring
up page rifile.

You can also page through a book using the Up/Down control on your

device.

Companion programs

Download from Www.Somanuals.com. All Manuals Search And Download.

5-21



Using Reader features

Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on
the pop-up menu, as described below.

Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title then tap
Return on the pop-up menu.

Copy Text. You can copy text form books that support this feature into
any program that accepts text. On a book page, select the text that you
want to copy. Then, tap Copy Text on the pop-up menu. The text can be
pasted into the program of your choice.

Bookmarks. When you add a bookmark to a book, a color-coded
bookmark icon appears on the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

Highlights. When you highlight text, it appears with a colored
background.

Notes. When you attach a note to text, you enter the text in a note pad
that appears on top of the book page. A Note icon appears on the left
margin. To show or hide the note, tap the icon.

Drawings. When you add a drawing, a Drawing icon appears on the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

NOTE To see a list of a book’s annotations, including bookmarks,
highlights, text notes, and drawings, tap Annotations Index
on the book’s cover page. You can tap an entry in the list to
go to the annotated page.

Removing a book

When you finish reading a book, you can delete it to conserve space on
your device. If a copy of the book is stored on your desktop computer, you
can download it again at any time.

To remove a book from your device, tap and hold the title in the Library list,
then tap Delete on the pop-up menu.
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Introduction

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in any
of these ways.

* During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile Favorites
sub-folder in the Internet Explorer on the desktop computer.

« Connect to an Internet service provider (ISP) or network and browse the
Web. To do this, you need to create the connection first. See Chapter 7
for information on creating a connection.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

Using Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting to
the Internet. You can also connect to the Internet through an ISP or a
network connection to browse the Web.

To launch Pocket Internet Explorer:

1. Tap B, then Internet Explorer W et Enlores. 5 HE220 €
to dISp|ay the POCket MSN file:} Powindowes pocketrmsn. bt -| @

services. 3
msn\! . Mew! Pocket MSN

Subscribe now to get popular MSN
services on your Pocket PCI
A& MSH Messenger® - Available virtually
I anywhere,
MSM Hobmail - Stay current! Manage
e-mail messages online and offline.
Alerts - Get personalized alerts about
weather, traffic, news, sports and more!
%! Mobile Web - Content at your
fingertips, on the qao.
Tap Continue For online pricing, availability and
device requirements,
*Suppotts Exchange Instant Messaging.

New Pocket MSN services

¥iew Tools G? @ f‘;} 3‘?/@ £|A
|

Tap to go back to previous page

Tap to stop/refresh

Tap to go to Pocket Internet Explorer home
Tap to launch Favorites
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2.

Tap the Home button to display
the Pocket Internet Explorer
welcome screen with links to
some useful Web sites.

Tap any of the Web site buttons to
go to a specific site.

Changing View settings

To change View settings:

1.

Tap View to display a pop-up
menu.

Tap Fit to Screen to see all the
screen items at the same time.

Tap Address Bar to display the
Web site address bar.

Tap and hold Text Size to display
another pop-up menu with a text
size selection. Select your desired
text size for the screen.

Browsing the Internet

To browse the Internet:

L.y'_f}"j’ Internet Explorer ¢ < 5:25 9

i ' Microsoft'
: Pocket Internet Explorer

Welcome to Pocket Internet
Explorer, Mot online yet? Find out
fiowy o get connected and save
offline content,

ASUS

@ Avant
PocketPC.com

view Tools ¢ &%) (3§ <> E|4

l.i‘rr'}' Internet Explorer 43 £ 9:76 9

i % Microsoft”
! Pocket Internet Explorer

Welcome to Pocket Internet
Explorer, Mot online yet? Find out
o to get connected and save
offline content.

v Fit to Screen

v Show Images
Address Bar
Text Size (3

om

History
Properties

ﬂTDDlS < @ o % E|A

1. Set up a connection to your ISP or corporate network using
Connections. See Chapter 7 for detalils.

2. Do one of the following to connect and start browsing:
« Tap the Favorites button, then tap the favorite that you wish to view.

« Tap View, then Address Bar. Enter the Web address that you want

to visit then tap Go.

Pocket Internet Explorer
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AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your device. Then, synchronize your device and
desktop computer, or connect to the Internet to download the content.

For more information, visit the AvantGo web site at http://avantgo.com/

To activate AvantGo:

1. In the ActiveSync window on your COTEE &

Sync Options ISchedu\eI Fules |

desktop computer, click Options.
2. Inthe Sync Options tab, check D 1ot i, s e ok o
. . |‘| Settings...
the box beside the AvantGo item. e
Click OK.

ActiveSync automatically updates
the settings and synchronizes

With your deVice. o Toenable, d\s;h\g or modify spnchronhization with & server,
?n;:cahj\’::;n:::::zatmn with a server Carfigurs..
Cancsl
NOTE Make sure that your computer is connected to the Internet.
3. When synchronization is F|internet Explorer &t 4¢8:20 €
complete, the AvantGo home &
page appears on your device. W AvantGo® .

@Theﬁulf[hannel -com

SIGN UP NOW & FOLLOW THE PGA

GET MORE CHAMMELS
My Channels

TO IaunCh AvantGO B CNET Tewws, carm

B The Sporking Mews
B USATODAY . com

1. In Pocket Internet Explorer on
TOOLE | PERZONALIZE

your device, tap the Favorites |
TheGol fChannel -com

button to display your list of N o r wow s Fotiow e pGA

favorites. #uetUJE:i:gDDSawSMMPDT __________
2. Tap the AvantGo Channels link '

to go directly to the AvantGo view Tools & &) 4} 7 [~

home page and see a few of the
most popular channels.

To add or remove channels:

Tap the Add or Remove link.
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Mobile Favorites folder

Only items items stored in the Mobile Favorites sub-folder in the Favorites
folder in the Internet Explorer on your desktop computer will be
synchronized with your device. This folder was created automatically when
you installed ActiveSync.

Favorite links

During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet
Explorer on your device. Both computers are updated with changes made
to either list each time you synchronize. Unless you mark the favorite link
as a mobile favorite, only the link will be downloaded to your device, and
you will need to connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on the desktop
computer.

Mobile Favorites

If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing mobile favorites downloads Web content to your device so
that you can view pages while you are disconnected from your ISP and
desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.

Pocket Internet Explorer 6-5
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To create a mobile favorite:

1.

In Internet Explorer on your desktop
computer, click Tools then Create
Mobile Favorite.

To change the link name, enter a new
name in the Name box.

Select your desired update schedule
in Update. This is optional.

Click OK. Internet Explorer downloads
the latest version of the page to your
desktop computer.

If you want to download the pages that
are linked to the mobile favorite you
just created, in Internet Explorer on the
desktop computer, right-click the
mobile favorite, then click Properties.
In the Download tab, specify the
number of links deep you want to
download. To conserve device
memory, go only one level deep.

Synchronize your device and your
desktop computer. Mobile favorites that
are stored in the Mobile Favorites in
Internet Explorer are downloaded to
your device.

NOTE

Create Mobile Favorite u x|
= 50 o ok
This will zend the page ta your mobile device
Cancel

Hame: |BSJ Favorites

<] [Eeeencd]

Update: |Do not zchedule updates

Create in: [ +] Mokile Favorites

'; Welcome to MSN.com - Microsoft Internet Explorer

| Fie Edt Wiew | Favertes Toos  Help
| Google-[ 1 unks Fhehweh G
1 Media 4 .=

..‘. @ e Open

= Explore
éj Radio Station G Search...
MSHN Home | My MRS ]

Add to Favorites, ,, b Favorites ¢

Organize Favarites. ..

Sharing...

Search the Weh: PC-cillin

Send To »
Cut

Copy
Paste

Create Shorkout
Delete
Rename

Gadgets and Garden
For Dad Up to 80% off

Sort by Mame
Properties

BiKinis to b

If you did not specify an update schedule in step 3, you will

need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing with your device, in Internet Explorer on your
desktop computer, click Tools then Synchronize. You will
see the last time content was downloaded to the desktop
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your desktop
computer, click View, Toolbars, and Customize.

Chapter 6
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Saving device memory

Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

In the settings for the Favorites information type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync Help.

Limit the number of downloaded linked pages. In Interner Explorer on
your desktop computer, right-click the mobile favorite you want to
change, then click Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.

Viewing mobile favorites and channels

To view mobile favorites and channels:

1. Tap 37 to display your list of favorites.

L.‘;Fgf Internet Explorer &7 =€ 5:23 @

Favorites

== Mobile Favorites

¢} BvantGo Channels
% MEN Mobile ——— Tap the favorite that
~[@ Pocket PC Web Guide you wish to view
(1) Packet PC.com
) WindowsMedia,com

Cpen | &dd | Delete

E|A

Tap to add or delete a
folder or favorite link

2. Tap a Favorites page that you wish to view.

You will see the page that was downloaded the last time you
synchronized with your desktop computer. If the page is not on your
device, the favorite is dimmed. You need to synchronize with your
desktop computer again to download the page to your device, or
connect to the Internet to view the page.

Pocket Internet Explorer 6-7

Download from Www.Somanuals.com. All Manuals Search And Download.



Adding/Deleting mobile favorites and folders

To add a favorite:

1.

Tap 77 to display your list of
favorites.

Tap the Add/Delete button to
display the Favorites screen.

Tap the Add... button to show the
Add Favorite screen.

Type a name for the favorite that

you wish to add in the Name field.

Type in the URL address in the
Address (URL) field.

Select a folder to place the
favorite from the Create in: box.

Tap Add to return to the Favorites
screen, which now shows the
favorite that you added.

To delete a favorite:

1.

6-8

Tap 17 to display your list of
favorites.

Tap the Add/Delete button to
display the Favorites screen.
Select the favorite that you wish
to delete, then tap Delete.

When prompted to permanently
delete the favorite, tap Yes.

{wj’ Internet Explorer 4F £ 5:78 @

Add Favorite

Marne:

|F‘ocket 1IE Home

Address (URL):

|Fi|e:,f,l"l,winu:lu:uws'l,default.htm

Create in:

<= Mobile Favorites

- MSH Mobile

(¥} Pocket PC.com

- AvantGo Charingls

- Pocket PC Weh Guide

| add

|| Cancel |

E|"

&:F Internet Explorer 4 £ 5:30

Favorites

Select an item to delete:

;}“_\g Internet Explorer
Favorite will be
permanently deleted,
Continue?
Yes NOo
| Add... || Delete || Mew Folder |
Qpen P.dd,fDeIete‘
[
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To add a folder:

1. Tap 37 to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the New Folder button.

4. Type a name for the folder that
you wish to create.

5. Tap Add to return to the Favorites
screen, which now shows the
folder that you added.

To delete a folder:

1. Tap %z to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the folder that you wish to
delete, then tap Delete.

4. When prompted to permanently
delete the folder, tap Yes.

Pocket Internet Explorer

L.f:gf Internet Explorer  ¢f #{Z 5:46 @

Mew Folder

Manne:
| e Fol

| Add || Cancel |

cer

1231[2]3]a]|s][e|7[8[0]0]-[=]|w

Tabjgfwle|r[t[y|ufifo[p[L]]

caplals[d[f[alh[j k1"

|
!

shift[z [x [c]v[b[n[m],[.[/]
culain] - [\ ] [L]t]e]=
=8

l&r@' Internet Explorer &7 = 5:46

Favorites

. Internet Explorer

The folder and the
favorites it contains will be
permanently deleted.
Continuea?

Yes No

=

| add... || Delete ||New Fulderl

Cpen | Add | Delete |

E|‘.
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Introduction

You can set up connections to the Internet and corporate network at work
in order to do such activities as browse the Internet or intranet, send and
receive e-mail and instant messages, and synchronize information using
ActiveSync.

Connections can be made using a modem, wireless network, or
network (Ethernet) card. A modem connection can be used to set up
connections with an external modem, or through your mobile phone
network using a cellular line.

Your device has two groups of connection settings: My ISP and My Work
Network. My ISP settings are used to connect to the Internet, and My
Work Network settings can be used to connect to any private network,
such as a corporate network you use at work. Simply fill in the settings and
get ready to start connecting. For more information, see the sections
“Connect to the Internet” or “Connect to Work.”

You may also establish connection to another device with infrared (IR) or
Bluetooth features. For more information, see sections “Infrared (IR)
connection” or “Bluetooth connection.”

Connect to the Internet

To connect to the Internet:

1. Obtain the following information from your ISP: ISP server phone
number, user name, and password.

2. Tap > Settings > Connections tab > Connections.

3. In My ISP, tap Add a new modem connection.

4. Create a modem connection. For more information, see section “Set
up modem connections.”

5. To start the connection, begin using the desired program. For example,
switch to Pocket Internet Explorer and browse a Web page. Your
device automatically connects.

NOTE To set up a network card or wireless network connection to
your ISP, add a new connection under My Work Network.

7-2 Chapter 7
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Connect to Work

1.

Obtain the following information from your network administrator:
server phone number, user name, and password.

Tap > Settings > Connections tab > Connections.

. In My Work Network, set up either a modem, network card, wireless

network, or VPN server connection. Refer to the section “Set up
connections” for the procedure.

To start the connection, start using a desired program. For example,
switch to Pocket Internet Explorer and browse to a Web page. Your
device automatically starts connecting.

Set up connections

Modem connections

To set up a modem connection:

Obtain the following information from your ISP or network administrator:
telephone number, user name, password, domain name, and TCP/IP
settings.

If your device does not have access to a mobile phone network, insert a
modem card.

1.

Tap > Settings > Connections tab > Connections.

2. To create a new connection, in either My ISP or My Work Network,

tap Add a new modem connection, then follow the instructions in the
New Connection wizard.

To view additional information for any screen in the wizard or while
changing settings, tap &

NOTE To change modem connection settings in either My ISP or My
Work Network, tap Manage existing connections. Select
the desired modem connection, tap Settings, and follow the
instructions on the screen.

Get connected 7-3
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VPN server connections

A VPN connection helps you to securely connect to servers, such as a
corporate network, via the Internet. Ask your network administrator for your
user name, password, domain name, TCP/IP settings, and host name or
IP address of the VPN server.

To set up a VPN server connection:

1. Tap > Settings > Connections tab > Connections.

2. To create a new VPN server connection, in My Work Network, tap Add
anew VPN server connection, then follow the screen instructions.

3. To view additional information for any screen in the wizard or while
changing settings, tap @&.

NOTE To change existing settings, in My Work Network, tap
Manage existing connections > VPN tab. Select your
desired VPN connection, tap Settings, then follow the
instructions on the screen.

Proxy server settings

If you are connected to your ISP or private network during synchronization,
your mobile device should download the proper proxy settings from your
PC. If these settings are not on your PC or need to be changed, ask your
ISP or network administrator for the proxy server name, server type, port,
type of Socks protocol used, and your user name and password.

To change proxy server settings:

1. Tap > Settings > Connections tab.

2. To create a new connection, in My Work Network, tap Add a new
proxy server.

3. To change proxy server settings, in My Work Network, tap Edit my
proxy server. Select the desired proxy server, and tap Settings.

4. Select This network connects to the Internet and This network uses a
proxy server to connect to the Internet.

5. Inthe Proxy server box, enter the proxy server name.

6. To change such settings as port number or proxy server type, tap
Advanced and change desired settings.
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Network card connections

Use a network (Ethernet) card to connect directly to a network. Once
connected, you can view the Internet or intranet, or download e-mail. You
do not need to create a new connection on your device. For more
information, see your network administrator. Make sure to purchase and
configure a network card that is compatible with your device.

To set up a network card:

1.

Obtain the following information from your network administrator: user
name, password, and domain name.

Insert the network card into your device.

The first time you insert the card, Network Settings appears
automatically so that you can configure the network card. If it does not

appeatr, or to change settings later, tap > Settings > Connections
tab > Connections > Advanced tab > Network Card.

If you need to enter specific server information, tap the appropriate
adapter, and then tap Properties. Most networks use DHCP, so you
should not have to change these settings unless your network
administrator instructs you to do so.

If necessary, connect the network card to the network by using a
network cable. For information, refer to the documentation that came
with your network card.

To start a connection, insert the network card, and begin using a
desired program. For example, switch to Pocket Internet Explorer
and browse a Web page. Your device automatically starts connecting.

If you use your network card with two networks, such as a private
network at work and one at home for the Internet, you need to change
the network to which the network card connects.

NOTE You may need proxy server and VPN connection settings.
For more information, see your network administrator.

Get connected
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Wireless network connections

Networks that you have already configured are preferred networks and are
listed in Wireless networks. You can select to connect to only preferred
networks or have your device search for and connect to any available
network whether it is preferred or not.

To set up a wireless network:

1.

Tap > Settings > Connections tab > Connections > Network
Card > Wireless tab.

To change network settings, in Wireless networks, tap a network. If
you do not see a desired network, tap Add new and follow the
instructions on the screen.

From Networks to access, select All available, Only access points,
or Only computer-to-computer depending on the type of network(s)
you connect to.

To connect only to networks you have already configured, clear
Automatically connect to non-preferred networks.

NOTE If you select to automatically connect to non-preferred
networks, your device detects any new networks and provide
you the opportunity to configure them.

Enter settings information

A wireless network can be added either when the network is detected, or
manually by entering settings information.

To enter new settings:

1.

7-6

To manually enter information, tap > Settings > Connections tab
> Connections > Network Card > Wireless tab. Then, tap Add new.
If the network was detected, step one is not necessary.

In the General tab, enter a network name. If the network was detected,
the network name is automatically entered and can't be changed.

From Connects to, select what your network connects to, Work or the
Internet.

To connect to an ad-hoc connection, select This is a device-to-
computer (ad-hoc) connection.
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Configure authentication settings

A wireless network can be added either when the network is detected, or
manually by entering settings information. To determine if authentication
information is needed, see your network administrator.

To configure authentication settings:

1. To manually enter information, tap > Settings > Connections tab
> Connections > Network Card > Wireless tab.

2. Tap Add new. If the network was detected, step one and two are not
necessary.

3. To use data encryption, tap Data encryption (WEP enabled).

4. To use Shared Key authentication, tap Network Authentication
(shared mode). You need a network key.

5. To automatically use a network key, tap The key is provided for me
automatically. Otherwise, enter the network key.

6. Forincreased security, select Use IEEE 802.1x network access
control, then select the appropriate EAP type.

Change connection settings name

Your mobile device is already set up with two sets of connection settings:
My ISP and My Work Network. You can change the name of these
settings to something more familiar. For example, if you put all of your
corporate settings under My Work Network, you can change the name
from My Work Network to your company name.

To change a connection name:

1. Tap > Settings > Connections tab > Connections.

2. Under My ISP or My Work Network, tap Manage existing
connections.

3. Tap the General tab.
4. Enter a name for the settings.

Get connected 7-7
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End a connection

* When connected via modem or VPN, tap «* on the navigation bar,
then tap Disconnect.

» When connected via cable or cradle, detach your device from the cable
or cradle.

* When connected via Infrared, move the device away from the other
computer or device.

» When connected via a network (Ethernet) card, remove the card from
your device.

* When connected via a wireless network, switch off the connection.

Set up a WAP gateway

To access WAP sites through Pocket Internet Explorer, configure your
device to use a WAP gateway. Use the following steps to create a new set
of connections to the Internet with WAP gateway settings.

NOTE Some device models do not support the WAP sites viewing
feature.

1. Get the following information from your ISP: ISP server phone number,
user name, and password. Also, contact your mobile phone service
provider and ask for your WAP gateway server name and port number.

2. Tap > Settings > Connections tab > Connections > Tasks tab.

3. Tap Edit my proxy server. If a proxy server has not been set up, tap Set
up My proxy server.

4. In Programs that automatically connect to the Internet should
connect using, tap New and enter a name for the ISP connection.

5. Onthe Proxy Settings tab, select This network connects to the
Internet and This network uses a proxy server to connect to the
Internet.

6. If necessary, in the Proxy server box, enter the proxy server name.
7. Tap Advanced.

8. Inthe WAP box, enter the WAP gateway server name. Under Port,
enter the port number. The most common WAP port number is 9201.

7-8 Chapter 7
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9. Create a modem connection. See section “Set up connections.”
If necessary, set dialing rules. See section “Use dialing rules.”

10. If your device does not have a connection to a mobile phone network,
insert a modem card.

Use dialing rules

Additional numbers may need to be dialed depending on your given
location when connecting. For example, if you want to dial from work, a 9
prefix must often be dialed, or an area code is needed.

To avoid creating a new modem connection for each situation, set dialing
rules for the locations from which you connect often. Three dialing
locations, Home, Mobile, and Work, have been created for you, and you
can create more. If a connection cannot be made, your device gives you
an opportunity to change the dialing location.

1. Tap > Settings > Connections tab > Connections > Advanced
tab.

2. Tap Select Location.
3. Tap Use dialing rules.
4. Select a location.
« Home - Dials the number as a local call without a 9 prefix.

« Work - Dials the number as local call with the 9 prefix.

NOTE To create a new location, tap New and follow the directions
on the screen. To view additional information at any time,

tap &

Get connected
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Infrared (IR) connection

By default, your device detects incoming infrared (IR) beams and prompts
you to accept them. If you do not want your device to detect or receive
beans, clear the Receive all incoming beams check box.

To set the Beam options:

1. Tap &, then Settings.
2. Tap the Connections tab.

3. Tap the Beam icon to display the
Settings screen.

g |settings 231 €

Personal | Swstem | Connections

2|

4. Make your desired change and tap OK.

5. To receive an infrared beam from this screen, tap the link at the
bottom. Your device automtically looks for another device using
infrared.

l.f;? Beam Receive 3 oz 7:34

Beam

Receive all incoming beams.

Looking For sending devices using
IR...

Receive an infrared beam from a Pocket PC
2000 or HfPC device.
|- B~
7-10 Chapter 7
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Sending information

To send information:

1. Switch to the program where you
created the item that you want to
send, and locate that item in the

list.

2. Align the IR ports so that they are
unobstructed and within a close

range.

3. Tap and hold the item, then tap
Beam File... on the pop-up menu.

L-E’? File Explorer

My Documents « Name «

& {21007 €3

Financial audi
rench transl]

6/4/03 1.95K |«
5/29/03 8848
RSAMI  1.44K

Copy

f&/1A_album
Kliasnap001

Rename
Delete

[Ef Little Bene
Market FESEd...
Meeting agen...

Beam File...

53 3 262K
5/29/03 964B
6/4/03 428B |
Ridint 426k |7

i up L

o |~

NOTE You can also send items, but not folders, from File Explorer.
Tap and hold the item that you want to send, then tap Beam

File on the pop-up menu.

Receiving information

To receive information:

1. Align the IR ports so that they are unobstructed and within a close

range.

2. Have the owner of the other device send the information to you. Your
device automatically receive the information.

Get connected
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Introducing Bluetooth™

Bluetooth is a short-range wireless communications technology. Devices
with Bluetooth capabilities can exchange information over a distance of
about 10 meters (30 feet) without requiring a physical connection.

Unlike infrared, you don’t need to line up the devices to beam information
with Bluetooth. The devices only need to be within a range of about 10
meters. You can even beam information to a device in a different room, as
long as it is within the specififed range.

Bluetooth™ for Windows® CE (BTW-CE)

BTW-CE is the solution to smoothly integrate the Bluetooth technology into
devices that use the Pocket PC operating system.

The Bluetooth technology allows your Pocket PC to:

» Locate other Bluetooth devices within the vicinity

» Discover the services that those devices offer

» Connect to, use, and disconnect from those services
* Enable or disable individual services

» Use security features including authentication, authorization, and
encryption

Bluetooth icon

The Bluetooth icon is located on the lower

right corner of the Today screen. Wednesday, July 09, 2003

[Z] Owner:Blanche Rosewell
. (556-2) 2890-7811
When B|uet00th IS enabled (tumed ON), _ Brainstorming session

) ) . PM-4:00PM (Rizal Conference Hall...
the icon is blue & , and the Bluetooth LED ! :
on the left side of the device blinks blue. -

When Bluetooth is disabled (turned OFF),
the icon is grayed with a red X on its lower

right corner 3.
Tapping the icon displays a menu that
allows you to:

* turn Bluetooth on or off Bluetooth icon
 launch the Bluetooth Manager
« change the Bluetooth Settings

8-2 Chapter 8
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Bluetooth settings

To configure the Bluetooth settings:

1. Tap kg from the lower right corner of
the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Settings.

3. Tap one of the tabs at the bottom of
the Settings screen to make your
desired changes.

General

Allows you to:

» select the user profile

» see the Bluetooth status (ON/OFF)
 turn Bluetooth ON or OFF

 tap alink to the Bluetooth Manager

Accessibility

Allows you to:

+ set the device name

+ see the Bluetooth Device Address
(BDA)

 select the remote devices you wish to
connect

* set whether to allow remote devices to
see your device

Bluetooth™

. o £ 3:00
(3 Wednesday, July 09, 2003

Owner: Blanche Rosewell
[BEE-2) 2890-7811
_ Brainstorming session
1:30PM-4:00PM (Rizal Conference Hall,..

gigas

& | o

Turn Bluetooth OFF

Bluetooth Manager
Bluetooth Settings

l.:'_ai;_';" Settings

Bluetooth: General

Current profile
19

Bluetooth status
Bluetooth is ON

IUse the Bluetooth Manager to set connections,
General ‘ accessibility | File Transfer ‘ Infcu| 4]k
E|‘

Bluetooth: Accessibility

Device Identification

Mame: |

Address:  00:02:C7:AD:948:9C

Accessibility
Allows other devices to connect
(@) Al devices
() Paired devices only
Other devices can discover me

Genetal | Accessibility | File Transfer | Infcu| 1)
E|‘
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File Transfer

Allows you to customize the settings for
file transfers, and set the highest level
directory on your device that remote
devices can access.

Refer to section “Remote device
services” for more information.

Information Exchange

Allows you to customize the service
settings, and set the default business
card.

Serial Port

Allows you to customize the service
settings, and display the serial port
addresses. The port address
assignments cannot be changed.

Refer to section “Remote device
services” for more information.

.E‘? Settings

Bluetooth: File Transfer

About this service
Enable service
[ ] authorization required
Authentication (Passkey) required
Encryption required
My shared folder
[ | &

General | Accessibility | File Transfer InFcJIE

|~

£3 |settings &t ¢ 338 (D

Bluetooth: Information Exchange

About this service
Enable service
[ ] authorization required
Authentication (Passkey) required
Encryption required
My business card {¥Card) [¥=| “$

Fosewell, Blanche
ASUS
2890-7811

File: Transfer | Information Exchange SerEI

|~

£3|settings & 42338 (D

Bluetooth: Serial Port

About this service
Enable service
[ ] autharization required
Buthentication (Passkey) required
Encryption required

Ports

Inbound COM Port:
Outbound COM Port: IZI

Information Exchange | Serial Port PersaEIj
E|‘
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Personal Network Server

Allows you to customize the service
settings for your personal network
Server.

Refer to section “Remote device
services” for more information.

Audio Gateway

Allows you to customize the service
settings for the Audio Gateway.

About

Displays the Bluetooth™ for Windows®
CE (BTW-CE) information including the
release version, copyright notice,
website address, technical support
email, and the Advanced button. The
Advanced buttons contains the version
information about the individual software
modules that make up BTW-CE.

The information on this screen is not
configurable.

Bluetooth™

l.f:F Settings

Bluetooth: Personal Network Server

About this service

Enable service
[] Autharization required
Authentication (Passkey) required

Encryption required

Setial Port | Personal Metwork Server AuEI

E|A

l&:}' Settings

Bluetooth: Audio Gateway

About this service
Enable service
[ ] autharization required
Authentication {Passkeyw) required
Encryption required

KD

Audio Gakeway ‘ About |

E|A

& 42339 (D

l.f:F Settings

Bluetooth: About

Bluetooth™ for Windows® CE (BTW-CE)
Yersion 1.4.1 Build 07

Copyright © 1999-2003 WIDCOMM Inc,

all rights reserved.

hiktpe f s, widcomm, com

Technical support: suppart@widcornm, com

KD
=

Audio Gakeway ‘ About |
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Bluetooth Manager

The Bluetooth Manager allows you to create, manage, and use Bluetooth
to connect to remote devices.

To launch the Bluetooth Manager:

Tap 2 | then tap the Bluetooth Manager
from the Start menu.

The My Shortcuts screen displays a list of pre-configured connections, if
any. Tap New > Connect to connect to other devices via Bluetooth.

The Active Connections screen displays the active incoming and outgoing
connections.

l.:'a_‘rr';" Bluetooth Manager & ={£ 3:09 9

$ Bluetooth $ Bluetooth
My Shortcuts Active Connections

l.:'a_‘rr';" Bluetooth Manager &7 4{£ 4:31 9

— Outgoing Connections

Tap Mew > Connect!
to access other devices via Bluetooth

— Incoming Connections

Iy Shortcuts | Active Connections | My Shorkcuts | Active Connections

New Tools Yiew &3 E=] E|‘ New Tools &) B9 E|‘

| Tlap to set Business Card excahnge options
Tap to launch the Bluetooth connection wizard
Tap to set view options
Tap to add or remove paired devices
Tap to make a new connection

Chapter 8
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Bluetooth connection wizard

The Bluetooth connection wizard helps you set up connections with
remote Bluetooth devices.

To launch the Bluetooth connection wizard:

1. Tap ‘W from the Bluetooth Manager
command bar. The Bluetooth
Connection Wizard screen appears.

2. Select a type of connection that you
wish set up. Tap Next.
Access the Internet using a nebwork,

Tap Cancel if you do not wish to :
) . access point, a cell phone of another
continue the connection process. CaiEChagalickootitphie:
\=m Join a personal network
- Connect bwo oF mare Bluetooth
devices to share files, collaborate or
play multiplaver games.,

ff}' Connection Wizard &7 ={£ 4:44

* Bluetooth
Connection Wizard

=% Connect to the Internet

C% Partner with a cell phone

Fatahlich a nartnershin with a cell

& Cancel MNext o
E|‘

NOTE Refer to the device online help for other information on
Bluetooth.

Bluetooth™
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Business Card Exchange

The Business Card Exchange function allows you to:

» send your business card to a remote device
* receive a business card from a remote device
» exchange business cards with one or more remote devices

To launch the Business Card Exchange screen:

1. Tap B5] from the Bluetooth Manager |[Firr i .
command bar. Bluetooth

) ) Business Card Exchange
2. Select the action that you wish to
make.

Send your business card ko one
of mare recipients using
Bluetooth,

Exchange business cards with
—| one or more individuals via
—' Bluetooth.

. Request a business card from a
o = single, or multiple Bluetooth
devices,

Select the business card to be used when
sending or exchanging cards.

]
NOTE From this screen, tap the link Select the business card to
go to the Information Exchange settings.
Chapter 8
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Remote device services

Wireless serial port

Using a Bluetooth serial port is equivalent to using a physical cable serial
port connection between two devices. As with a physical connection, you
have to configure the application that will use the serial port.

To configure the Bluetooth Serial Port:

1. Tap &g from the lower right corner £|settings
of the Today screen to display the NPT Erm—
Bluetooth menu. About this service
2. Tap Bluetooth Settings, then the EZ?:;‘Z‘:;‘:;EE "
Serial Port tab. Authentication (:asskey) required
3. Note the assigned Outbound B e e
COM Port 6 and configure the T oo
application that will use the outbound coMmport:  [5 ]
Bluetooth serial port to send data
to this port.
Information Exchange | Serial Pork I?EI
=8
NOTE Refer to the application’s documentation for more information

about configuring your application’s Outbound COM port.

4. From the Bluetooth Manager My Shortcuts screen, open the Bluetooth
Serial Port connection to the remote device.

5. Send/receive data from the application.

Bluetooth™
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Dial-up networking

The Dial-up Networking feature allows you to connect to a rmeote
computer through a phone line. Once connected, you can browse the
Internet, check/read emails, etc.

NOTE The remote Bluetooth device that will provide the Dial-up
Networking service should have access to a telephone
system, either a hard-wired or a cellular connection, and
capable of answering a call.

Devices that may provide a Dial-up Networking service:

* Bluetooth-enabled cellular telephones
» Bluetooth-enabled desktop computers attached to a telephone system
* Bluetooth modems

To use Dial-up Networking:

1. Create a connection to the device that will provide telephone access.
See the section “Bluetooth connection wizard” on page 8-7.

2. Tap =& , then the Bluetooth Manager from the Start menu.
3. In My Shortcuts screen, tap and hold the Dial-up Networking

Connection shortcut, then select Connect from the pop-up menu.

4. On the first Bluetooth: Dial-up Connection screen, double-tap New
Connection... OR select New Connection then tap OK.

5. Key-in the following informatin on the second Bluetooth: Dial-up
Connection screen:

« Name for a connection

« Country code (if dialing outside the default contry setting)
» Area code (if dialing outside the default area code setting)
* Phone number to be dialed

Tap OK.

Enter the required information on the succeeding screens to complete
the connection process.

8. When the connection is active, open a web browser from the device.

N o
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Bluetooth file explorer

The Bluetooth File Explorer appears automatically after a file transfer
connection is established.

This service feature allows you to do the following operations:

» Navigate the directory structure of the remote device

* View the files and folders on the remote device

» Create new folders on the remote device

« Send files to, and copy or get files from the remote device
* Delete files from the remote device

NOTE The file operations on the remote device are limited to the
configured FTP root directory and sub-directories of the
remote device.

The Bluetooth File Explorer also allows you to set a folder in your device
for receiving inbound files. You may configure this folder for each of your
connection shortcuts. See the section “To set a local folder” on page 8-13.

Bluetooth File Explorer menus

File == Send a File...
Create a Folder
Get
Delete

Tools == Set Local Folder
Refresh

To change the remote device folder:

1. To move down in the directory structure of the remote device, tap the
New Folder from the main window of Bluetooth File Explorer.

2. To move up in the directory structure of the remote device, tap the
down-arrow to the right of the currently selected folder and select the
New Folder from the drop-down list.

Bluetooth™ 8-11
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To create a folder on the remote device:

Select the folder in which you wish to place the new folder.
From the File menu, tap Create a Folder.

Enter a name for the new folder while the default name New Folder is
highlighted.

To send a file to the remote device:

1.

From the File menu, tap Send a File... to display the Open screen.
The Open screen includes the following:

Folder - tap the down-arrow and select the folder that contains the file
you wish to send

Type - default and only option is “All Files (*.*)

A list of files in the selected folder - tap a file that you wish to send
Cancel button - abort the Send a File... operation

Tap your desired operation.

The file that you selected is automatically sent when tapped, after
which the Bluetooth File Explorer re-appears.

To get a file from the remote device:

1.
. Tap the file that you wish to get or copy.

Select the folder containing the file.

From the File menu, tap Get.
OR
Tap and hold the desired file and select Get from the pop-up menu.

The file is copied to the local folder listed in the Local Folder field at the
bottom of the screen.

To delete a file from the remote device:

1.

Tap the file that you wish to delete.

2. From the File menu, tap Delete.
3. Tap OK in the confirmation dialog box.

8-12

OR
Tap and hold the desired file and select Delete from the po-up menu.
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To set alocal folder for incoming files:

1. From the Tools menu, tap Set Local Folder.

2. Use the drop-down menu at the top of the screen to go to your desired
folder.

3. Tap OK to return to the main screen of Bluetooth File Explorer. You will
see the Local Folder field is updated to reflect the new folder selection.

NOTE The Local Folder information is associated with the currently
open shortcut and is saved with the active profile. You can
separately configure your Local Folder for each connection
shortcut.

To refresh the list of displayed files and folders on the remote device,
simply tap Refresh from the Tools menu.

Bluetooth™ 8-13
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Send via Bluetooth

You can conveniently send your Pocket Outlook contacts, calendar items,
and tasks individually or collectively to the remote device via Bluetooth.

To send data via Bluetooth:

1.

8-14

Tap &, then either Contacts,
Calendar, or Tasks.

Highlight an item that you wish to
send to the remote device.

Tap and hold the item, then tap
Send via Bluetooth from the
pop-up menu.

OR

Tap Tools from the command bar,
then select Send via Bluetooth.

On the Select a Bluetooth Device
screen, tap the name of the
destination, then tap OK.

f*}' Contacts

All Contacts +

& 4i629 €3

|Find a name |

#ab|cde] fgh [ ik [Imn]opal rst Juww] zyz

Alba, Susan
Ang, Eugene
Ang, Precious
Baiias, Arnel

Dossmni Dakl

0919-4590617
400-4222 x103
&§13-0080
552-6798

£2c neny kg 98 loc.
7

-

Beam Contact...
Delete Contact

29914
1
34865

Send via Bluetooth

Dial via Bluetooth

, 2431328
35574
5

Espino, ¥Yangie
Estaura, Wil...
Evangelista, ...

524-0344
729-8888
288-5567

CFER RN P

Mew Yiew Tools

1]
b

fly Contacts

& d26:29 €9

Domingo, No...

All Contacts ~ |Find a name |
#ab|cde] foh | ik [ Imn]opa] rst Juvw] sz
Canzon, Fe B633-8277 W (a
Casifio, Cynt... 0919-7329914 m [ |
Chavez, Arm... 644-8451 h
Chong, Frey 0917-8334865 m
Cruz, Mila 0919-2235574 m [

h

w

Espino, Yangie 524-0344

T76-B565

Copy Contacts o
Evangelis h

Delete Contacts =
Floresta, i w
Gonzales, Beam Contacts h
Juliano, E Dptions... h
Legaspi, Y m
Macapagd Send via Bluetooth m
Mapoy, Rq Dial via Bluetooth |
Mew ¥iew |Tools E|A
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Dial via Bluetooth

The Dial via Bluetooth option allows you to select a contact from the
Pocket Outlook contacts list, and have your paired cell phone dial the
contact’s phone number. If a contact has more than one phone number,
select the number that you wish to dial. You may also modify a phone
number before you dial.

To dial via Bluetooth:

1. From the Pocket Outlook Contacts screen, tap and hold a contact and
select Dial via Bluetooth.

2. If your device is paired with more than one cell phone, or if a phone is
not yet selected, tap the phone icon next to Select a phone, and
choose the phone that you wish to use.

3. Select the number that you wish to dial, then tap Dial Number.

4. To modify the number, tap Edit Number and make your desired
changes. Tap OK to return to the previous screen.

NOTE If you modify a phone number, a dialog box appears with an
option to save or to discard the modification.

5. Tap Dial Number.

After the number is sent to the cell phone, the connection on the
device is closed.

After the cell phone completes the dialing process, you can use the
use the phone the normal way.

Bluetooth™ 8-15
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Bluetooth Personal Area Network

A Bluetooth personal area network is a private, temporary, ad-hoc network
of up to eight (8) devices. A Bluetooth personal area network allows you to
easily exchange information that normally requires a TCP/IP network.
Most chat utilities, multi-player games, etc. are fully functional in a
Bluetooth personal area network environment.

Bluetooth private area networks are subject to the same security settings
(service availability, authorization, authentication, and encryption) that
govern other Bluetooth communications.

One Bluetooth device must be the host of the personal area network.
Other Bluetooth devices join the network as clients. The host cna accept
and reject clients on an individual basis.

To set up a Bluetooth personal area network:

1. From the Bluetooth Manager, g |connection wizard &t € 8:42
select New>Connect> Join a Bluetooth Connection Wizard
personal network. Tap Next. S DRt e

. jon Pl lect wheth Id like &

2. On the wizard screen, select Host jo?naifﬁisica?efsonearl\feutwwﬂ. e

i | k
a personal network, then tap T T
Next_ devi;e hosting a personal network,
SESSI00N,
i | k,

3. Add remote devices to the ®lls i e
Bluetooth personal network, if Blustooth devices to Form a
des"‘ed personal netwark,

' Tap Mext' to continue, To exit this
izard, ! I
a. Tap the Add button and select e, tap cance
the device that you wish to add. D Caricel WEack  Nedt®
. . . B[«
b. Add other devices, if desired. |
There can be up to eight devices,
including the host.

4. After adding devices, tap OK to
complete the setup and close the
wizard.

NOTE Adding devices is optional. You do not have to add devices to

the personal network while configuring the host. You can let
other devices join the personal network later.
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To join a personal network:

1.

From the Bluetooth Manager,
select New>Connect>Join a
personal network. Tap Next.

On the wizard screen, select Join
a personal network, then tap
Next. The Bluetooth browser
appears.

Select the host of the personal
network, then tap Next to
establish a connection to the
personal area network.

If you are asked to enter IP network

settings, select Use server-
assigned IP address, then tap
OK.

Bluetooth™

l&:} Connection Wizard &7 ={ 8:27

Bluetooth Connection Wizard

Join a personal netwark,

Please select whether you would like to
' join or host a personal network,
o e
() Ioin a personal netwark
Select this option to connect to a

device hosting a personal network
SES5IAM.

() Hast a personal netwark
Choose this option to connect other
Blustooth devices to Form a
personal netwark,

Tap Mext' to continue, To exit this
wizard, tap 'Cancel'.

& Cancel P Back MNext g

E|‘
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Federal Communications Commission Statement

This device complies with FCC Rules Part 15. Operation is subject to the following two
conditions:

»  This device may not cause harmful interference, and

«  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
manufacturer’s instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

»  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

»  Consult the dealer or an experienced radio/TV technician for help.

WARNING! The use of shielded cables for connection of the monitor to
the graphics card is required to assure compliance with FCC
regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

A-2 Appendix
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UL Safety Notices

Required for UL 1459 covering telecommunications (telephone) equipment intended to be
electrically connected to a telecommunication network that has an operating voltage to ground that
does not exceed 200V peak, 300V peak-to-peak, and 105V rms, and installed or used in
accordance with the National Electrical Code (NFPA 70).

When using the Pocket PC, basic safety precautions should always be followed to reduce the risk
of fire, electric shock, and injury to persons, including the following:

» Do not use the Pocket PC near water, for example, near a bath tub, wash bowl, kitchen sink
or laundry tub, in a wet basement or near a swimming pool.

* Do not use the Pocket PC during an electrical storm. There may be a remote risk of electric
shock from lightning.

* Do not use the Pocket PC in the vicinity of a gas leak.

Required for UL 1642 covering primary (nonrechargeable) and secondary (rechargeable) lithium
batteries for use as power sources in products. These batteries contain metallic lithium, or a lithium
alloy, or a lithium ion, and may consist of a single electrochemical cell or two or more cells
connected in series, parallel, or both, that convert chemical energy into electrical energy by an
irreversible or reversible chemical reaction.

* Do not dispose the Pocket PC battery pack in a fire, as they may explode. Check with local
codes for possible special disposal instructions to reduce the risk of injury to persons due to fire
or explosion.

* Do not use power adapters or batteries from other devices to reduce the risk of injury to
persons due to fire or explosion. Use only UL certified power adapters or batteries supplied by
the manufacturer or authorized retailers.

Replaceable batteries

If an equipment is provided with a replaceable batterym and if replacement by an incorrect type
could result in an explosion (e.g. with some lithium batteries), the following applies:

— if the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking close
to the battery or a statement in both the operating and the servicing instructions;

— if the battery is placed elsewhere in the equipmen, there shall be a marking close to the
battery or a statement in the servicing instructions.
The marking or statement shall include the following or similar text:

CAUTION
RISK OF EXPLOSION IF BATTERY IS REPLACED
BY AN INCORRECT TYPE.
DISPOSE OF USED BATTERIES ACCORDING

THE INSTRUCTIONS
Compliance is checked by inspection.

Operator access with a tool

If a TOOL is necessary to gain access to an OPERATOR ACCESS AREA, either all other
compartments within that area containing a hazard shall be inaccessible to the OPERATOR by the
use of the same TOOL, or such compartments shall be marked to discourage OPERATOR access.

An acceptable marking for an electric shock hazard is (1ISO 3864, No. 5036)

Equipment for restricted access locations

For equipment intended only for installation in a RESTRICTED ACCESS LOCATION, the
instalation instructions shall contain a statement to this effect.

Notices A-3
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